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2 S9
安全上のご注意
ご使用の前に、必ずこの「安全上のご注意」をよくお読みください。

ここに示した注意事項は、製品を安全に正しくご使用いただき、お客様や他の方々への危害や財産への損害
を未然に防止するためのものです。必ずお守りください。
お読みになったあとは、使用される方がいつでも見られる所に必ず保管してください。

■ 記号表示について
この製品や取扱説明書に表示されている記号には、次のような意味があります。

■「警告」と「注意」について
以下、誤った取り扱いをすると生じることが想定される内容を、危害や損害の大きさと切迫の程度を明示す
るために、「警告」と「注意」に区分して掲載しています。

■ 本体に表示されている注意マークについて
本体には、次の注意マークが付いています。

これは、以下の内容の注意を喚起するものです。
「感電防止のため、パネルやキャビネットを外さないでください。この製品の内部には、お客様が修理 /交換
できる部品はありません。点検や修理は、必ずお買い上げの楽器店または巻末のヤマハ修理ご相談センター
にご依頼ください。」

「ご注意ください」という注意喚起を示します。

～しないでくださいという「禁止」を示します。

「必ず実行」してくださいという強制を示します。

警告
この表示の欄は、「死亡す
る可能性または重傷を負
う可能性が想定される」
内容です。

注意
この表示の欄は、「傷害を
負う可能性または物的損
害が発生する可能性が想
定される」内容です。

注 意
感電の恐れあり

キャビネットをあけるな
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 警告

電源は必ず交流100Vを使用する。
エアコンの電源など交流 200V のものがあります。
誤って接続すると、感電や火災のおそれがあります。

電源プラグにほこりが付着している場合は、ほこり
をきれいに拭き取る。
感電やショートのおそれがあります。

電源コード/プラグは、必ず付属のものを使用する。
他の電源コード/プラグを使用すると、発熱や感電の
原因になります。

電源コードをストーブなどの熱器具に近づけたり、
無理に曲げたり、傷つけたりしない。また、電源コー
ドに重いものをのせない。
電源コードが破損し、感電や火災の原因になります。

この製品の内部を開けたり、内部の部品を分解した
り改造したりしない。
感電や火災、けが、または故障の原因になります。

本体の上に花瓶や薬品など液体の入ったものを置か
ない。また、浴室や雨天時の屋外など湿気の多いとこ
ろで使用しない。
内部に水などの液体が入ると、感電や火災、または故
障の原因になります。入った場合は、すぐに電源ス
イッチを切り、電源プラグをコンセントから抜いた
上で、お買い上げの楽器店または巻末のヤマハ修理
ご相談センターに点検をご依頼ください。

ぬれた手で電源プラグを抜き差ししない。
感電のおそれがあります。

本体の上にろうそくなど火気のあるものを置かな
い。
ろうそくなどが倒れたりして、火災の原因になりま
す。

電源コード/プラグがいたんだ場合、または、使用中
に音が出なくなったり異常なにおいや煙が出たりし
た場合は、すぐに電源スイッチを切り、電源プラグを
コンセントから抜く。
感電や火災、または故障のおそれがあります。至急、
お買い上げの楽器店または巻末のヤマハ修理ご相談
センターに点検をご依頼ください。

電源 /電源コード

必ず実行

必ず実行

必ず実行

禁止

分解禁止

禁止

水に注意

禁止

禁止

火に注意

禁止

異常に気づいたら

必ず実行
3S90 XS/S70 XS 取扱説明書
(1)-18 2/4



4 S9
 注意

アースプラグを確実に取り付ける。
感電のおそれがあります。（アースプラグの取り付け
方については16ページをご参照ください。）

電源プラグを抜くときは、電源コードを持たずに、必
ず電源プラグを持って引き抜く。
電源コードが破損して、感電や火災の原因になるこ
とがあります。

長期間使用しないときや落雷のおそれがあるときは、
必ずコンセントから電源プラグを抜く。
感電や火災、故障の原因になることがあります。

たこ足配線をしない。
音質が劣化したり、コンセント部が異常発熱して火
災の原因になることがあります。

直射日光のあたる場所（日中の車内など）やストーブ
の近くなど極端に温度が高くなるところ、逆に温度
が極端に低いところ、また、ほこりや振動の多いとこ
ろに置かない。
本体のパネルが変形したり、内部の部品が故障した
りする原因になります。

テレビやラジオ、ステレオ、携帯電話など他の電気製
品の近くで使用しない。
楽器本体またはテレビやラジオなどに雑音が生じる
場合があります。

不安定な場所に置かない。
本体が転倒して故障したり、お客様や他の方々がけ
がをしたりする原因になります。

本体を移動するときは、必ず電源コードなどの接続
ケーブルをすべて外した上で行なう。
コードをいためたり、お客様や他の方々が転倒した
りするおそれがあります。

この機器を電源コンセントの近くに設置する。
電源プラグに容易に手の届く位置に設置し、異常を
感じた場合にはすぐに電源スイッチを切り、電源プ
ラグをコンセントから抜いてください。また、電源ス
イッチを切った状態でも微電流が流れています。こ
の製品を長時間使用しないときは、必ず電源プラグ
をコンセントから抜いてください。

他の機器と接続する場合は、すべての機器の電源を
切った上で行なう。また、電源を入れたり切ったりする
前に、必ず機器のボリュームを最小にする。さらに、演
奏を始める場合も必ず両機器のボリュームを最小に
し、演奏しながら徐々にボリュームを上げていき適切
な音量にする。
感電または機器の損傷の原因になることがあります。

本体を手入れするときは、ベンジンやシンナー、洗
剤、化学ぞうきんなどは使用しない。
 本体のパネルや鍵盤が変色/ 変質する原因になりま
す。お手入れには、乾いた柔らかい布、もしくは水を
固くしぼった柔らかい布をご使用ください。

水滴がついたらすぐに拭きとる。
極端に温湿度が変化すると、本体表面に水滴がつく
（結露する）ことがあります。水滴をそのまま放置す
ると、木部が水分を吸収して変形する原因になりま
す。水滴がついた場合は、柔らかい布ですぐに拭き
とってください。

電源 /電源コード

必ず実行

必ず実行

必ず実行

禁止

設置

禁止

禁止

禁止

必ず実行

必ず実行

接続

必ず実行

手入れ

禁止

必ず実行
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本体のすき間に手や指を入れない。
お客様がけがをするおそれがあります。

パネル、鍵盤のすき間から金属や紙片などの異物を
入れない。
感電、ショート、火災や故障の原因になることがあり
ます。入った場合は、すぐに電源スイッチを切り、電
源プラグをコンセントから抜いた上で、お買い上げ
の楽器店または巻末のヤマハ修理ご相談センターに
点検をご依頼ください。

本体上にビニール製品やプラスチック製品、ゴム製
品などを置かない。
本体のパネルや鍵盤が変色 / 変質する原因になりま
す。

本体の上にのったり重いものをのせたりしない。ま
た、ボタンやスイッチ、入出力端子などに無理な力を
加えない。
本体が破損したり、お客様や他の方々がけがをした
りする原因になります。

大きな音量で長時間ヘッドフォンを使用しない。
聴覚障害の原因になります。

作成したデータの保存とバックアップ
DRAMのデータは電源を切ると消えてしまいます。
保存しておきたいデータはUSB記憶装置などの外部
機器に保存してください。

また、フラッシュROMに保存(ストア)したデータは
故障や誤操作などのために失われることがありま
す。大切なデータは、USB記憶装置などの外部機器に
保存してください。

フラッシュROMへの書き込み中(画面に
「Executing... Please keep power on.」と表示さ
れます)に、絶対に電源を切らないでください。
ユーザーメモリー上のデータが失われたりシステム
データが壊れたりして、次に電源を入れたときに正
常に起動しなくなる恐れがあります。

USB記憶装置/外部メディアのバックアップ
保存したUSB記憶装置/外部メディアの万一の事故
に備えて、大切なデータは予備のUSB記憶装置/外部
メディアにバックアップとして保存されることをお
すすめします。

●データが破損したり失われたりした場合の補償はいたし
かねますので、ご了承ください。

●不適切な使用や改造により故障した場合の保証はいたし
かねます。

使用後は、必ず電源スイッチを切りましょう。

使用時の注意

禁止

禁止

禁止

禁止

禁止

データの保存

必ず実行

禁止

必ず実行

ヤマハ製品では、機能や操作性向上のために、不定期に製
品本体のファームウェアおよび付属のアプリケーションソ
フトウェアをアップデートすることがあります。
シンセサイザー製品の最新バージョンについては、以下の
ウェブサイトで確認、ダウンロードすることができます。
お使いのS90 XS/S70 XSにつきましても、本体ファー
ムウェアや付属アプリケーションソフトウェアを最新バー
ジョンにアップデートされることを推奨します。

http://www.yamaha.co.jp/product/syndtm/

なおこの取扱説明書では、本書制作時のバージョンで説明
しております。
お使いのS90 XS/S70 XS のバージョンの確認方法やそ
の機能 / 操作についても、上記ページでご確認いただきま
すようお願いします。

音楽を楽しむエチケット
楽しい音楽も時と場所によっては、大変気になるものです。
隣近所への配慮を充分にいたしましょう。静かな夜間には
小さな音でもよく通り、特に低音は床や壁などを伝わりや
すく、思わぬところで迷惑をかけてしまうことがあります。
夜間の演奏には特に気を配りましょう。窓を閉めたり、ヘッ
ドフォンをご使用になるのも一つの方法です。お互いに心
を配り、快い生活環境を守りましょう。
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S96
はじめに～開発チームから皆様へのメッセージ～
このたびはヤマハミュージックシンセサイザーS90 XS/S70 XSをお買い上げいただきまして、まことにありがとうござい
ます。

S90 XS/S70 XSは、ハイクオリティーな楽器音色とリアルなタッチのピアノ鍵盤を備えたシンセサイザー「S90 ES」の
後継モデルとして、世界中のミュージシャン、プレーヤーのために開発されたモデルです。長年のシンセサイザー開発で培っ
た経験をもとに、主にステージでの演奏性や操作性を追求することで、トッププロとして活躍するミュージシャンのニーズに
お応えするだけでなく、本格的な演奏や音色を追求するアマチュアミュージシャンの皆様にも非常に使いやすいシンセサイ
ザーを目指して開発を行ないました。また、今回は76鍵モデル「S70 XS」を新たに開発しました。鍵盤のタッチは88鍵モ
デルそのままで、より可搬性を重視したモデルです。
そして、S90 XS/S70 XSの魅力はそれだけではありません。本格的な音楽制作でのニーズにもお応えできるよう、リモート
コントロール機能やマスターキーボードとしての機能も充実しています。
ライブステージ、レコーディングといったミュージシャンを取り巻くあらゆるシーンで、S90 XS/S70 XSがユーザーの皆様
のお力になれることを嬉しく思います。

S90 XS/S70 XSの持つ力を最大限に発揮していただくために、ぜひこの取扱説明書をご活用いただきますようご案内申し上
げます。また、ご一読いただいたあとも不明な点が生じた場合に備えて、大切に保管いただきますようお願い申し上げます。
S90 XS/S70 XSを通じて、皆様の音楽活動がよりよいものになることを心よりお祈りしています。

ヤマハS90 XS/S70 XS開発チーム一同

付属品
• 電源コード
• 2P-3P変換器
• 取扱説明書(本書)
• 取扱説明書CD-ROM×1枚(リファレンスマニュアル、データリスト収録)
• DVD-ROM×1枚(付属DAWソフトウェア)
• 保証書

同梱ディスクについて
ご注意
• 付属のソフトウェアの著作権は、Steinberg Media 
Technologies GmbH社が所有します。

• 巻末に付属のソフトウェアのご使用条件が記載されていま
す。付属のソフトウェアをインストールする前に、必ずこ
のご使用条件をお読みください。ディスクの包装を解かれ
た場合は、付属のソフトウェアのご使用条件に同意したこ
とになります。

• 付属のソフトウェアおよび取扱説明書の一部または全部を
無断で複製、改変することはできません。

• 付属のソフトウェアおよび取扱説明書を運用した結果およ
びその影響については、一切責任を負いかねますのでご了
承ください。

• 付属のソフトウェアのディスクは、オーディオ用ではあり
ません。一般のオーディオ・ビジュアル用のCD/DVDプ
レーヤーでは絶対に使用しないでください。

• ヤマハ株式会社では、付属のソフトウェアについてのサ
ポートは、一切行なっておりません。

付属DAWソフトウェアについて
同梱のDVD-ROMディスクには付属DAWソフトウェアが
入っています(Windows/Macintosh)。

NOTE
• 付属DAWソフトウェアをインストールするときは、管理者権限のある
アカウントで行なってください。

• 付属DAWソフトウェアを継続してご使用いただくために、ユーザー登
録とソフトウェアライセンス認証が必要です。登録と認証は、イン
ターネットに接続した状態で付属DAWソフトウェアを起動したときに
行なえます。起動時に表示される「今すぐ登録」ボタンをクリックし、
表示されたすべての項目を入力してください。登録と認証をされない
場合は、インストール後、一定期間のみご使用いただけます。

• Macintoshの場合は、「pkg (拡張子)」のアイコンをダブルクリック
してインストールします。

付属のソフトウェアおよび最新の動作環境については、下記
のURLをご参照ください。
http://www.yamaha.co.jp/product/syndtm/smtg/

サポートについて
付属DAWソフトウェアについては、Steinberg社のホーム
ページをご覧ください。Steinberg社のホームページでは、
製品に関するサポート情報や最新のアップデータのダウン
ロード、FAQなどを下記URLにて公開しております。
http://japan.steinberg.net/

付属DAWソフトウェアの[ヘルプ(Help)]メニューから
Steinberg社のホームページにアクセスできます。(ヘルプ
メニューには付属DAWソフトウェアのPDFマニュアルや追
加情報なども掲載されています。)
0 XS/S70 XS 取扱説明書



S90 XS/S70 XSの特長

■ 高品位なピアノ音色を含む総計456MBのバリエーション豊かな音色を内蔵
「S90 XS/S70 XS」には、新たにサンプリングされた高品位なピアノ音色を含む142MBのピアノ音色と、
ミュージックプロダクションシンセサイザー「MOTIF XS」直系のバリエーション豊かな音色が総計456MB内蔵
されています。

■ 自然なタッチ感と表現力を実現する88鍵/76鍵バランスドハンマー鍵盤
アコースティックピアノで培ったノウハウを凝縮したバランスドハンマー鍵盤(イニシャル/アフタータッチ付)を採
用しています。本格的なピアノ演奏に対応する88鍵モデルと、可搬性を重視した76鍵モデルが用意されています。

■ 気に入ったボイスからそのままパフォーマンスを作成できる「パフォーマンスクリエーター」
気に入ったボイスを元にレイヤーやスプリット、ドラムアサインを簡単に行なうことができる「パフォーマンス
クリエーター」を搭載しています。ボイスの持つエフェクトや設定をそのまま活用して、スピーディーに音色作り
ができます。

■ 演奏中でも直感的に操作できるパネル構成
パネル上のボタンやノブ、スライダーは、演奏中でも直感的に操作できるよう考慮して配置されています。たとえ
ば、パフォーマンスのパート選択やオン/オフ、アルペジオのオン/オフやホールドなどを切り替えて、ノブやスラ
イダーでパラメーターをエディットすることがスムーズにできます。また、演奏中の誤操作を防ぐパネルロック機
能や、アルペジオのタップテンポ機能といった、ライブ演奏中に便利な機能もすべてパネル上に用意されています。

■ 本体での演奏を録音したり、オーディオファイルの再生が可能な「オーディオレコード/プレイ」機能
本体での演奏をUSB記憶装置や本体の内蔵メモリーにスケッチ感覚でオーディオ録音したり、DAWソフトウェア
などで制作したオーディオファイルを再生できます。オーディオファイルを再生しながらのライブ演奏も可能です。

■ さまざまな音楽制作シーンに対応するDAWリモート機能
音楽制作シーンでも活用できるDAWリモート機能を搭載しています。主要DAWソフトウェアのコントロールは
もちろん、主要VSTインストゥルメントに対応するコントロールテンプレートを最大50種類本体に保存できます。

■ VST3対応音色エディター、リモートエディターによる詳細エディットが可能
VST3対応のCubaseシリーズを使用する場合は、S90 XS/S70 XSをVSTインストゥルメントと同様に操作がで
きる「S90 XS/S70 XSエディターVST」を使用して、細かい音作りや音楽制作を行なうことができます。スタ
ンドアローンで使用する場合は、Studio Manager Version2対応の「S90 XS/S70 XSエディター」を使用し
て、同様の細かい音作りができます。また、リモートコントロールの設定やテンプレートは「S90 XS/S70 XSリ
モートエディター」で簡単に管理できます。いずれのソフトウェアもWebからダウンロードが可能です。
http://www.yamaha.co.jp/product/syndtm/dl/
S90 XS/S70 XS 取扱説明書 7



S98
取扱説明書について

本書
主にパネル上での操作について説明しています。

PDFマニュアル(同梱CD-ROM)

● リファレンスマニュアル
主に機能の詳細やエフェクトパラメーター、音色パラメーターについて説明しています。

● データリスト
ボイス、ウェーブなどのプリセットデータのリストや、MIDIに関する資料、パフォーマンス、マスタープログラム、マル
チ、アルペジオタイプのリストと、リモートコントロール機能一覧を掲載しています。

ご注意
• 取扱説明書の著作権はすべてヤマハ株式会社が所有します。
• この取扱説明書に掲載されているイラストや画面は、すべて操作説明のためのものです。したがって、実際の仕様と異なる場合があ
ります。

• この製品は、ヤマハ(株)が著作権を有する著作物やヤマハ(株)が第三者ら使用許諾を受けている著作物を内蔵または同梱しています。
その著作物とは、すべてのコンピュータープログラムや、伴奏スタイルデータ、MIDIデータ、WAVEデータ、音声記録データ、楽
譜や楽譜データなどのコンテンツを含みます。ヤマハ(株)の許諾を受けることなく、個人的な使用の範囲を越えて上記プログラムや
コンテンツを使用することについては、著作権法等に基づき、許されていません。

• この製品には、XGフォーマット以外の音楽/サウンドデータを扱う機能があります。その際、元のデータをこの楽器に最適化して動
作させるため、オリジナルデータ(音楽/サウンドデータ)制作者の意図どおりには再生されない場合があります。ご了承のうえ、ご
使用ください。

• ヤマハ(株)および第三者から販売もしくは提供されている音楽/サウンドデータは、私的使用のための複製など著作権法上問題にな
らない場合を除いて、権利者に無断で複製または転用することを禁じられています。ご使用時には、著作権の専門家にご相談される
などのご配慮をお願いします。

• Windowsは、米国Microsoft Corporationの米国およびその他の国における登録商標です。
• Macintoshは、米国および他の国々で登録されたApple Inc.の商標です。
• SteinbergおよびCubaseは、Steinberg Media Technologies GmbH社の登録商標です。
•「MIDI」は社団法人音楽電子事業協会(AMEI)の登録商標です。
• その他、本書に記載されている会社名および商品名等は、各社の登録商標または商標です。

PDFマニュアルの活用方法
リファレンスマニュアルとデータリストは、電子ファイル(PDF形式)になっています。これらの電子ファイルは、コン
ピューターを使ってご覧いただくことができます。コンピューターでご覧いただくソフトウェアとして「Adobe® 
Reader®」を使うと、用語をすばやく検索したり、必要な部分のみ印刷したり、リンクをクリックして該当する項目を
開いたりすることができます。特に用語検索とリンク機能は、電子ファイルならではの便利な機能です。ぜひご活用くだ
さい。

最新のAdobe Readerは下記のURLよりダウンロードできます。
http://www.adobe.com/jp/products/reader/
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S910
各部の名称と機能

フロントパネル

1 鍵盤
S90 XSは88鍵、S70 XSは76鍵で構成されています。
アコースティックピアノのように、弾き方の強弱でボイスの音
量や音色をコントロールできるイニシャルタッチと、鍵盤を弾
いたあとさらに押し込むことによって音色を変化させるアフ
タータッチの、2種類のタッチレスポンス機能がついており、
ダイナミックな表現力を得られます。
NOTE S90 XSの鍵域はA-1～C7、S70 XSの鍵域はE0～G6です。

2 ピッチベンドホイール
ピッチベンド効果のアップ/ダウンをコントロールします。その
他、さまざまな機能を割り当てて使用できます。

3 モジュレーションホイール
モジュレーション効果をコントロールします。その他、さまざ
まな機能を割り当てて使用できます。

4 MASTER VOLUME (マスターボリューム)
スライダー

マスターボリュームを調節します。スライダーを上へスライド
させるほど、OUTPUT L/R端子やPHONES端子からの出力が
大きくなります。

5 [MIC ON/OFF](マイク オン/オフ)ボタン
ボタンを押すことにより、MIC INPUT端子からの入力のオン/
オフを切り替えます。

6 INPUT GAIN (インプットゲイン)ノブ
MIC INPUT端子から入力される信号のゲインを調節します。接
続したマイクの信号レベルに合わせて調節します。右に回すと
入力信号が大きくなり、左に回すと小さくなります。

7 PEAK (ピーク)ランプ
MIC INPUT端子から入力される信号が－3dB以上になるとこ
のランプが点灯します。入力する音が最も大きな音の時にこの
ランプが一瞬点灯するようにINPUT GAINノブを調節してくだ
さい。

8 パフォーマンスコントロールボタン群
パフォーマンスやマルチの音色をコントロールするためのボタ
ン群です。ノブによる音色コントロールの対象となるパートを
選択したり、アルペジオに関するパラメーターをパート別に設
定したりすることができます。マルチモードでは、選択されて
いるパート(カレントパート)によって、設定できるパートが1～
4、5～8、9～12、13～16と変わります。
 

[COMMON](コモン)ボタン
パフォーマンスモードのときに、ノブでの操作対象をコモ
ンパラメーターに切り替えます。パフォーマンスエディッ
トモード、マルチエディットモード、マスターエディット
モードのときは、コモンエディットセレクト画面に移動し
ます。

[PART SELECT](パートセレクト) 1～4 ボタン
パフォーマンスモード、マルチモードのときに、ノブで操
作するパートを選択します。
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各部の名称と機能
[PART ON/OFF](パートオン/オフ) 1～4 ボタン
パフォーマンスモードのときは、各パートのパートスイッ
チのオン/オフを、マルチモードのときは、各パートの
ミュートのオン/オフを切り替えます。
ボイスモードのときはパート1のみ有効で、常にオンとなり
ます。

[ARP ON/OFF](アルペジオ オン/オフ)ボタン
コモンパラメーターの「Arp Switch」のオン/オフを切り
替えます。各モードでアルペジオを使うときはオンにしま
す。

[PART ARP](パートアルペジオ) 1～4 ボタン
パフォーマンスモード、マルチモードのときに、各パート
のアルペジオのオン/オフを切り替えます。
ボイスモードのときはパート1のみ有効で、[ARP ON/
OFF]ボタンと同じ機能となります。

[HOLD](ホールド) 1～4 ボタン
パフォーマンスモード、マルチモードのときに、各パート
のアルペジオが鍵盤を離してもなり続けるようにするかし
ないかを切り替えます。具体的には、各パートパラメー
ターの「Arp Hold」のオン/オフを切り替えます。
ボイスモードのときはパート1のみ有効です。

9 スライダーファンクションボタン
ボタンを押すことにより、4つのスライダーに割り当てる機能
を切り替えます。ランプが点灯している機能が割り当てられま
す。ボイスモードのときはパート1のみが有効です。
ボイスエディットモードのときにこのボタンを何度か押して各
機能のランプをすべて消すと、スライダーでボイスのエレメン
トレベルを調整できます。

) スライダー
スライダーファンクションボタン(9)で選択されたパラメー
ターの値を調節します。ボイスモードのときはパート1のみが
有効です。パフォーマンス/マルチモードのときは、操作したス
ライダーに対応するパートのパートパラメーターを設定します。
マスターモードでは、「Zone Switch」と「Knob Slider 
Zone Switch」がどちらもオンのときは、各ゾーンで設定され
ているコントロールチェンジの値を調節し、それ以外のときは
ボイス/パフォーマンス/マルチモードと同じ動作をします。

NOTE スライダーがすべて0になっている場合(すべて下がりきってい
る場合)、本体の音が鳴らない可能性があります。鍵盤を弾いて
も音が鳴らない場合は、スライダーの位置を上げてみてくださ
い。

NOTE MASTER VOLUMEスライダーでは、本体から出力されるオー
ディオ音声のボリュームを調節します。それに対して、4つの
スライダーではパフォーマンス/マルチの各パートのボリューム
やノーマルボイスの各エレメントを、パラメーターの設定値と
して変更することになります。したがって変更された値は、
ボイス、パフォーマンス、マルチデータとして保存(ストア)でき
ます。
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各部の名称と機能
! ノブファンクションボタン
ボタンを押すことにより、4つのノブに割り当てる機能を切り
替えます。ランプが点灯している段の機能が割り当てられます。
ボイスモードでは、各機能がボイス全体に働き、パフォーマン
スモードでは、[COMMON]ボタンと[PART SELECT]ボタン
を使って、全パート共通に働く場合と任意のパートだけに働く
場合とで切り替えられます。

NOTE このボタンで選択できる機能のうち、[EFFECT]のパラメー
ターは常に全パート共通に働き、[MIC]のパラメーターは独立し
て働きます。

@ ノブ
4つのノブを回すことで、演奏中のボイスの音色やエフェクト
に関する設定など、さまざまなパラメーターを調節できます。
左どなりにあるノブファンクションボタンを押すことにより、
ノブの機能を切り替えます。

# アルペジオ/エフェクト ファンクションボタン
ボタンを押すことにより、5つのファンクションボタンに割り
当てる機能を切り替えます。アルペジオ1～5の選択機能と、
エフェクトのオン/オフを切り替える機能とを選択できます。

$ [DAW REMOTE](DAWリモート)ボタン
ボタンをオンにすると本体はリモートモードになり、パネルのボ
タンやコントローラーを使って、本体に接続したコンピューター
上のDAWソフトウェアをコントロールできるようになります。

% ファンクションボタン
リモートモードのときはパネル上のアイコンどおり、5つのボ
タンにそれぞれ「トップ(先頭に戻る)」、「リピートオン/オフ」、
「ストップ(停止)」、「プレイ(再生)」、「レコード(録音)」が割り
当てられます。それ以外のモードのときは、アルペジオ/エフェ
クト ファンクションボタンで選択された機能が働きます。

^ ASSIGNABLE FUNCTION (アサイナブル
ファンクション) [1]/[2]ボタン

より多彩な表現を実現するために、リアルタイムにエレメント
を変化させるボタンとして機能します。また、さまざまな機能
を割り当てて使用できます。

& OCTAVE (オクターブ)[－][＋]ボタン
これらのボタンを押すたびに、鍵盤を1オクターブずつダウン/
アップさせることができます。2つのボタンを同時に押すと標
準の音の高さ(0)に戻ります。

* TRANSPOSE (トランスポーズ)[－][＋]ボタン
これらのボタンを押すたびに、鍵盤を1半音ずつダウン/アップ
させることができます。2つのボタンを同時に押すと標準の音
の高さ(0)に戻ります。

( LCD (液晶ディスプレイ)
バックライト付きの液晶ディスプレイです。さまざまな情報を
表示します。

A [SHIFT](シフト)ボタン
他のボタンと組み合わせることでいろいろな働きをします。
主な機能は下記のとおりです。

NOTE すべての機能は別PDFファイル「データリスト」に記載してい
ます。

B データダイアル
LCD画面(ディスプレイ)中のカーソルがある位置の値を、変更
する時に使います。右に回す(時計回り)と値が増加し、左に回
す(反時計回り)と値が減少します。設定レンジの広いパラメー
ターは、ダイアルを速く回すほど、変化量が大きくなります。

C [INC](インク)ボタン
LCD画面(ディスプレイ)中のカーソルがある位置の値を、1つ
ずつ増やす(INC=increment)ことができます。

! @

$

^ & *

#

%

[SHIFT]ボタンと
組み合わせるボタン

機能

START/STOP クリック(メトロノーム)のオン/オフ

AUDIO REC/PLAY オーディオレコード/プレイモードのRec画面
に移動

VOICE エディット中のボイスをバルク送信

PERFORM エディット中のパフォーマンスをバルク送信

MULTI/SEQ PLAY エディット中のマルチをバルク送信

ENTER アルペジオのタップテンポ

DEC/INC、
データダイアル

プレイ画面ではプログラムナンバーを－10/
＋10
エディット画面では、選択しているパラメー
ター値を－10/＋10

カーソル[L]/[R] 各モードのプレイ画面で、通常画面とシンプル
画面の切り替え

ノブ 1～4 速くパラメーターを変更

FAVORITE 現在のボイス/パフォーマンスをフェーバリッ
トカテゴリーに登録/解除

PANEL LOCK Utility Panel Lock画面に移動
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各部の名称と機能
D [DEC](デック)ボタン
LCD画面(ディスプレイ)中のカーソルがある位置の値を、1つ
ずつ減らす(DEC=decrement)ことができます。

E カーソルボタン
LCD画面(ディスプレイ)中のカーソル(反転表示部分)を上下左右
に移動させる場合に使用します。

F [EXIT](エグジット)ボタン
S90 XS/S70 XSのLCD画面に表示される機能は階層構造に
なっています。設定中に１つ上の階層画面に戻るときに、この
ボタンを使います。また、ストアやジョブを中止する場合(NO)
に使用します。

G [ENTER](エンター )ボタン
選択した項目の画面を呼び出すときに、このボタンを使います。
また、各ジョブやストア操作の実行(EXECUTE)と確認(YES)
にも使用します。

H モードボタン
ボイスモードをはじめ、S90 XS/S70 XSの各モードに入るた
めのボタンです。

I PEFORMANCE CREATOR 
(パフォーマンスクリエーター )

選択しているボイスを元にパフォーマンスを作るためのボタン
です。この機能で作られるパフォーマンスには選択しているボ
イスのエフェクトなどもすべてコピーされますので、元のボイ
スの雰囲気を活かした音作りが可能です。

[LAYER](レイヤー )ボタン
現在選択しているボイスを元に、レイヤーされたパフォー
マンスを作るボタンです。ボタンを押すとカテゴリーサー
チ画面が表示され、レイヤーする音色を選択できます。

[SPLIT](スプリット)ボタン
現在選択しているボイスを元に、スプリットされたパ
フォーマンスを作るボタンです。ボタンを押すとカテゴ
リーサーチ画面が表示され、スプリットする音色を選択で
きます。

[DRUM ASSIGN](ドラムアサイン)ボタン
現在選択しているボイスを元に、ドラムボイスを組み合わ
せたパフォーマンスを作るボタンです。ボタンを押すとカ
テゴリーサーチ画面が表示され、ドラムボイスを選択でき
ます。またアルペジオも自動的にオンになります。

J BANK [DEC]/[INC](バンク デック/インク)
ボタン

ボイス/パフォーマンスバンクを切り替えます。

K [CATEGORY SEARCH](カテゴリーサーチ)
ボタン

ボイス/マルチ/パフォーマンスパートエディットモードでこの
ボタンをオンにすると、[A]～[H]ボタンが、ボイスのメインカ
テゴリー選択用のボタンとして機能します。パフォーマンス
モードでこのボタンをオンにすると、[A]～[H]ボタンが、パ
フォーマンスのメインカテゴリー選択用のボタンとして機能し
ます。

L [FAVORITE](フェーバリット)ボタン
自分の好きなボイス/パフォーマンスだけを集めた「フェーバ
リットカテゴリー (お気に入りのカテゴリー )」を呼び出すボタ
ンです。また、[SHIFT]ボタンを押しながらこのボタンを押す
と、現在選択されているプログラムをフェーバリットカテゴ
リーに登録できます。よく使うボイスをフェーバリットカテゴ
リーに登録しておけば、次から素早くボイスを選ぶことができ
ます。

M [A]～[H]ボタン
ナンバー [1]～[16]ボタンと組み合わせて、ボイス/パフォーマ
ンス/マルチ/マスタープログラムを切り替えます。
カテゴリーサーチ機能を使用している時は、メインカテゴリー
選択ボタンとして機能します。

N [PART](パート)ボタン
[MUTE](ミュート)ボタン
[SOLO](ソロ)ボタン

ナンバーボタンの機能を切り替えます。ナンバー [1]～[16]ボ
タン(P)をご参照ください。

O [PANEL LOCK](パネルロック)ボタン
パネル上のボタン、ノブ、スライダーの操作を無効にします。
演奏中の誤動作を防ぐために使います。ピッチベンド/モジュ
レーションホイール、フットスイッチ、[INPUT GAIN]ノブ、
マスターボリュームは対象外です。ユーティリティーモードの
Panel Lock画面でパネルロックの対象にするボタンを選択でき
ます。

H I

K L

M

P

N

O
J
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各部の名称と機能
P ナンバー [1]～[16]ボタン
[PART]ボタン、[MUTE]ボタン、[SOLO]ボタンのオン/オフ状態
により、以下のような機能を持たせることができます。各ボタンは、
オンの場合にランプが点灯します。

モード [PART]ボタン [MUTE]ボタン [SOLO]ボタン

ボイスプレイ キーボード送信チャンネルの切替 ― ―

ノーマルボイスエディット ― 各エレメントの選択([1]～[8])
各エレメントのエレメントスイッチ オン
/オフ設定([9]～[16])

ソロエレメントの選択
([1]～[8]もしくは[9]～[16])

パフォーマンスプレイ キーボード送信チャンネルの切替 各パートのミュートオン/オフ設定
([1]～[4])

ソロパートの選択([1]～[4])

パフォーマンスエディット パフォーマンスパート選択([1]～[4]) 各パートのミュートオン/オフ設定
([1]～[4])

ソロパートの選択([1]～[4])

マルチプレイ マルチパート選択([1]～[16]) 各パートのミュートオン/オフ設定
([1]～[16])

ソロパートの選択([1]～[16])

マルチエディット マルチパート選択([1]～[16]) 各パートのミュートオン/オフ設定
([1]～[16])

ソロパートの選択([1]～[16])

マスタープレイ ボイスモード/パフォーマンスモードが
登録されている場合はキーボード送信
チャンネルの切替、マルチモードが登録
されている場合はパート選択

パフォーマンスモード、マルチモードが
登録されている場合は、各パートの
ミュートオン/オフ設定

パフォーマンスモード、マルチ
モードが登録されている場合は、
ソロパートの選択

マスターエディット コモンエディットからゾーンエディット
に切替、またはゾーン選択([1]～[4])

― ―

P

N
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各部の名称と機能
リアパネル

1 P (電源スイッチ)
電源のオン(O)/オフ(N)スイッチです。

2 AC IN (ACイン)端子
付属の電源コードを接続します。
付属の電源コード以外は使用しないでください。

3 MIDI IN/OUT/THRU端子
MIDI IN端子は外部MIDI機器から送信されるMIDIメッセージを
受信します。外部MIDI機器からS90 XS/S70 XSをコント
ロールしたり、音源部を鳴らしたりすることができます。また、
MIDI OUT端子からはS90 XS/S70 XSの演奏情報やパネルの
コントローラーやノブなどの操作情報をMIDIメッセージとして
送信します。S90 XS/S70 XSで他のMIDI音源を鳴らしたり、
外部のMIDI機器をコントロールできます。
MIDI THRU端子はMIDI IN端子で受信したMIDIデータをそのま
ま出力する端子です。複数のMIDI機器を接続するときに使用し
ます。

4 FOOT SWITCH (フットスイッチ)端子
別売のフットスイッチ(FC3、FC4、FC5)を接続します。
SUSTAIN (サステイン)端子に接続したフットスイッチはサス
テイン専用に使います。ASSIGNABLE (アサイナブル)端子に
接続したフットスイッチには、サステイン以外にもさまざまな
機能を割り当てることができます。
SUSTAIN (サステイン)端子にはフットスイッチFC3、FC4、
FC5を、ASSIGNABLE (アサイナブル)端子にはフットスイッ
チFC4、FC5を使用できます。

5 FOOT CONTROLLER 1、2 
(フットコントローラー1、2)端子

別売のフットコントローラー (FC7など)を接続します。音色、
音量、音の高さなどを足元でコントロールできます。

6 LCD CONTRAST (LCDコントラスト)ノブ
画面表示の濃さを調節します。正面から見て時計回りの方向に
回すと表示が濃くなります。

7 USB端子
本体リアパネルに、2種類のUSB端子がついています。USB 
TO HOST端子は、本体とコンピューターのUSB端子とを、
USBケーブルで接続するために使います。これにより、コン
ピューターと本体とでMIDIデータの送受信ができます。MIDI
ケーブルでの送受信と違って、USBケーブルではポート信号を
扱えます。コンピューターと本体とのUSB接続では、MIDIデー

タだけを扱います。オーディオデータは扱いませんのでご注意
ください。
USB TO DEVICE端子は、本体とUSB対応の記憶装置(USBフ
ラッシュメモリー、ハードディスクドライブ、CD-ROMドライ
ブなど)を接続するために使います。これにより、本体で制作し
たデータを外部記憶装置に保存(セーブ)したり、また外部記憶装
置から本体へデータを読み込むこと(ロード)ができます。外部記
憶装置と本体とのデータのやりとりは、ファイルモード(47ペー
ジ)で行ないます。

8 ASSIGNABLE OUTPUT L、R 
(アサイナブルアウトプット左、右)端子

OUTPUT端子とは別に、特定の音やパートを独立して出力させ
ることができるアナログ出力端子です。特定の音やパートだけ
に、本体とは違うエフェクトをかけたい場合などに使います。
独立して出力できる音、またはパートは以下のとおりです。

• ドラムボイス各キーに割り当てられた楽器音
• パフォーマンスの各パート*
• マルチの各パート*
• クリック(メトロノーム)
*オーディオ入力パート(A/Dパート)を含む

9 OUTPUT L/MONO、R 
(アウトプット左/モノラル、右)端子

S90 XS/S70 XSのオーディオ信号を出力する端子(標準
ジャック)です。モノラル出力したい場合は、L/MONO端子だ
けに接続します。

) PHONES (ヘッドフォン)端子
ヘッドフォンを接続します。ステレオ標準ジャックです。

! MIC INPUT (マイクインプット)端子
本体へ外部オーディオ信号を入力する端子(コンボジャック)で
す。マイクを接続し、入力音声をパフォーマンスモード、マル
チモードでのオーディオ入力パート(A/Dパート)として鳴らす
ことができます。接続には、XLR (オス)プラグかモノラル標準
プラグを使います。

1

2

3 4 5

8 9 ) !

76
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S916
ご使用前の準備

電源の準備
次の順番で、付属の電源コードを接続します。電源コードを
接続する前に、S90 XS/S70 XSの電源がOFFになってい
ることを確認してください。

1 付属の電源コードのプラグを本体リアパネルの
AC IN端子に接続します。

2 電源コードのもう一端のプラグを電源コンセント
(AC100V)に接続します。

NOTE 電源コードを外すときは、逆の手順で行なってください。

注意
S90 XS/S70 XSは、アース線の使用を前提として設計されています。
感電と機器の損傷を防ぐため、電源コードにはアース端子が付いていま
す。コンセントにプラグを差し込むときは、アース端子を接続してくだ
さい。なお、接続方法がわからないときは、巻末のヤマハ修理ご相談セ
ンターにご相談ください。

警告
電源コードは、必ず付属のものをお使いください。他の電源コードを使
用すると、発熱や感電の原因になります。

警告
電源は必ずAC100Vを使用してください。

注意
電源スイッチがOFFの状態でも微電流が流れています。長時間使用しな
いときは必ず電源コードを電源コンセントから抜いてください。

スピーカーやヘッドフォンの準備
音を鳴らすための準備をします。キーボードアンプやモニ
タースピーカー、ヘッドフォンをご用意いただき、下図のよ
うに接続します。接続の際には、接続する機器を確認して、
別途ケーブルをご用意ください。

電源を入れる
電源を入れる前に、S90 XS/S70 XSとキーボードアンプ
やモニタースピーカーのボリュームが、0になっていること
を確認します。
キーボードアンプやモニタースピーカーに接続しているとき
は、次の順番で電源をON/OFFしてください。

電源を入れるとき
ボリュームを0 → S90 XS/S70 XSをON → アンプまた
はスピーカーをON

電源を切るとき
ボリュームを0 → アンプまたはスピーカーをOFF → S90 
XS/S70 XSをOFF

S90 XS/S70 XSの電源スイッチは、リアパネル右寄りの
AC IN端子の上にあります。

または

AC IN端子

2P-3P変換器(付属)

 (電源スイッチ)
コンセント OUTPUT L/MONO端子 OUTPUT R端子

PHONES端子

ヘッドフォン

キーボードアンプ
またはモニタースピーカー

（左側）

キーボードアンプ
またはモニタースピーカー

（右側）

S90 XS/S70 XS
0 XS/S70 XS 取扱説明書



ご使用前の準備
ボリュームや画面の明るさを
調節する
S90 XS/S70 XSやアンプのボリュームを最適な位置に調
節します。

NOTE アンプやPA機器に接続する場合は、S90 XS/S70 XSの
ボリュームを7分目くらいに合わせてから、アンプやPA機器の
ボリュームを上げていきます。

画面が見えにくい場合は、リアパネルにあるLCD 
CONTRASTノブを回して調節します。

注意
大きな音量で長時間ヘッドフォンを使用しないでください。聴覚障害の
原因になります。

音を出す
実際にS90 XS/S70 XSの鍵盤を弾いて音を鳴らしてみま
しょう。S90 XS/S70 XSの電源を入れると、以下のよう
な画面が表示されます。

NOTE 初期状態では、電源を入れると「マスターモード」のプレイ画
面が表示されます。モードについては19ページをご参照くださ
い。

NOTE ここに掲載している、マスターモードのプレイ画面は、操作説
明のためのものです。したがって、実際とは異なる場合があり
ます。たとえば、ここに掲載しているプログラム名は、仮名称
です。

この時点で本体の鍵盤を弾くと、現在表示されているプログ
ラムの音色を鳴らせます。
初期状態のマスターモードに登録されているプログラムは、
S90 XS/S70 XSの中でもおすすめの音色を使ったプログ
ラムです。まずは鍵盤を弾いてみて、S90 XS/S70 XSの
リアルな音を楽しんでください。

マスターモードのプレイ画面には、現在選ばれているプログ
ラムの種類(モード、バンク、プログラムナンバー )と、プロ
グラムの名前、マスターモードにおけるプログラムのナン
バーが表示されます。

NOTE「バンク」については、「ボイスを選ぶ」(21ページ)、
「パフォーマンスを選ぶ」(32ページ)をご覧ください。

音を選ぶ
初期状態のマスターモードには、「ボイス」、「パフォーマン
ス」、「マルチ」という3種類の演奏プログラムの中にある、
おすすめのプログラムが合計128種類登録されています。
マスターモードのナンバーを切り替えて、いろいろなボイス
やパフォーマンスを選び、鍵盤演奏してみましょう。マス
ターモードのナンバーを切り替えるには、データダイアルや
[DEC]ボタン、[INC]ボタンを使います。

デモソングを聴く
S90 XS/S70 XSには、あらかじめデモンストレーション用
のソングが内蔵されています。次の手順で聴いてみましょう。

NOTE 16ページの「ご使用前の準備」を参照して接続などのセット
アップを行ない、S90 XS/S70 XSから音が出る状態にしてく
ださい。

1 [FILE]ボタンを押しながら[UTILITY]ボタンを
押します。

2 デモソングプレイ画面が表示されます。カーソル
[U]/[D]ボタンやデータダイアルで、聴きたい曲
を選びます。

3 [ENTER]ボタンを押すと、デモソングの演奏が
始まります。
デモソング演奏中に[ENTER]ボタンを押すと演奏が一時停
止し、もう一度[ENTER]ボタンを押すと、停止したところ
から演奏が再開します。

4 [EXIT]ボタンを押すと、演奏が停止します。

5 デモソング画面を終了するには、[EXIT]ボタン、
または[VOICE]/[PERFORM]/[MASTER]/
[MULTI/SEQ PLAY]ボタンを押します。

S90 XS/S70 XS

マスターボリューム
スライダーの調節コントラストの調節

大

小

濃 淡

プログラムナンバーバンクモード

マスターモードにおける
プログラムのナンバープログラムの名前

次のナンバーを選ぶ前のナンバーを選ぶ

次のナンバーを
選ぶ

前のナンバーを
選ぶ
S90 XS/S70 XS 取扱説明書 17
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ご使用前の準備
工場出荷時の状態に戻す
(ファクトリーセット)
S90 XS/S70 XSには、メモリーを初期化して工場出荷時
の状態に戻すファクトリーセットという機能があります。
S90 XS/S70 XSでは、はじめからさまざまなボイス、
パフォーマンス、マルチが設定されています。
ファクトリーセットを実行すれば、これらを誤って書き換えて
しまった場合でも、工場出荷時の状態に戻すことができます。

注意
ファクトリーセットを実行すると、内部メモリーの内容が、すべて工場
出荷時の設定に書き換えられてしまいます。また、内蔵フラッシュメモ
リーの内容はすべて消去されます。大切なデータを失わないようにご注
意ください。また、必要なファイルや設定内容は、あらかじめUSB記憶
装置に保存されることをおすすめします(47ページ)。

1 [UTILITY]ボタンを押します。
ユーティリティーセレクト画面が表示されます。

2 カーソル[U]/[D]/[L]/[R]ボタンで、「Fctry 
Set」を選択し、[ENTER]ボタンを押します。
Factory Set画面が表示されます。

注意
「Auto Factory Set (パワーオンオートファクトリーセット)」を「on」
に設定してファクトリーセットを実行すると、電源を入れ直すたび、自
動的にファクトリーセットを実行するように設定されます。
必要なデータが失われてしまう可能性があるため、通常はオフに設定し
ておいてください。自動的にファクトリーセットを実行しない設定に戻
すには、「off」に設定してファクトリーセットを実行します。
ファクトリーセットを実行すると、自動的に設定が保存されます。

3 [ENTER]ボタンを押して、ファクトリーセット
を実行します。
実行を確認するダイアログが表示されます。再度[ENTER]
ボタンを押して実行します。
ファクトリーセットが終了すると、自動的にマスタープレ
イ画面を表示します。
また、ファクトリーセットの実行をやめたい場合は、
[EXIT]ボタンを押します。

注意
ファクトリーセットの実行に時間がかかる場合は、画面に「Now 
executing Factory set...」と表示されます。これらのメッセージが表
示されている間は、絶対に電源を切らないでください。ユーザーメモ
リー上のデータが失われたりシステムデータが壊れたりして、次に電源
を入れたときに正常に起動しなくなるおそれがあります。
0 XS/S70 XS 取扱説明書



スタートガイド

S90 XS/S70 XSでは、7つのモードボタンを使って、モードを切り替えます。
鍵盤演奏用や音楽制作用のモードとして、ボイスモード、パフォーマンスモード、マルチモード、マスターモード、シーケン
スプレイモードがあります。
この中から、鍵盤演奏にはボイスモードやパフォーマンスモード、音楽制作にはマルチモードなど、目的に応じて使いわけて
ください。
そのほか、本体の演奏を録音したり、オーディオファイルを再生するオーディオレコード/プレイモード、本体の設定を行なう
ユーティリティーモード、データのバックアップなどを行なうファイルモードがあります。

モードについて

1つの音色で鍵盤演奏する

ボイスモード
[VOICE]ボタン

高品位でバリエーション豊かな音色(ボイス)
を使った鍵盤演奏が楽しめるモードです。同
時に使用できるボイスは1つだけです。オリ
ジナルのボイスを作成することもできます。

複数の音色で鍵盤演奏する

パフォーマンスモード
[PERFORM]ボタン

パフォーマンスの演奏、作成ができるモード
です。パフォーマンスを使えば、ボイスを複数
重ねて同時に鳴らしたり、左右に鍵盤の領域
をわけて、別々のボイスを鳴らしたりできます。

演奏を録音する/
オーディオデータを再生する

オーディオレコード/プレイ
[AUDIO REC/PLAY]ボタン

S90 XS/S70 XS本体での演奏をUSBス
トレージや内蔵フラッシュメモリーの最上位
の階層にオーディオファイルとして録音した
り、指定したストレージのオーディオファイル
を再生することができます。

自分だけのプログラムセットをつくる

マスターモード
[MASTER]ボタン

ボイス、パフォーマンス、マルチモードで作っ
たプログラムを使って設定する特別なモード
です。マスターモードには2つの使い方があ
ります。
●お気に入りのプログラムを集めておく
ボイス、パフォーマンス、マルチの各モードで
作ったお気に入りのプログラムを集めて登録
することで、ワンタッチで呼び出せるように
なります。
●マスターキーボードとして使う
S90 XS/S70 XS鍵盤を4つの領域にわ
けることで、あたかもMIDIキーボードが4つ
あるかのように使用できます。

データをバックアップする

ファイルモード
[FILE]ボタン

S90 XS/S70 XSのデータをUSB記憶装
置や内蔵フラッシュメモリーに保存したり、
USB記憶装置や内蔵フラッシュメモリーのデ
ータをS90 XS/S70 XSに読み込みます。
S90 XS/S70 XSのデータは本体にストア
(保存)しておくことができますが、万一に備え
てUSB記憶装置にもバックアップしておくこ
とをおすすめします。

システム設定する

ユーティリティーモード
[UTILITY]ボタン

S90 XS/S70 XSのシステム全体に共通し
た設定を行ないます。ここでの設定は、すべ
てのボイス、パフォーマンス、マルチに適用さ
れます。

外部シーケンサーを使って曲をつくる

マルチモード
[MULTI/SEQ PLAY]ボタン

S90 XS/S70 XSを外部シーケンサー用の
マルチ音源として利用するモードです。複数
のパートにボイスを割り当て、同時に演奏させ
ることができます。

オーディオ/
MIDIファイルを再生する

シーケンスプレイモード
[MULTI/SEQ PLAY]ボタン

外部シーケンサーなどで作成した複数の
SMFファイルや、44.1kHz/16ビットステレ
オのオーディオファイルを、順番に再生する
モードです。USB記憶装置や内蔵フラッシュ
メモリーに保存したファイルを直接再生しま
す。

NOTE [MULTI/SEQ PLAY]ボタンを
押すたびに、マルチモードと
シーケンスプレイモードを切り
替えられます。
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S920
S90 XS/S70 XSの基本は、ボイスモードで作成する「ボイス」
パフォーマンス、マルチなどすべてのプログラムは「ボイス」が基本となります。
本体には、膨大な数のボイスがプリセットされています。まずは、プリセットされているボイスを弾いてみて自分にあった音
色を探してみましょう。慣れてきたら、自分だけのオリジナル音色もつくってみましょう。

ボイスを組み合わせて、「パフォーマンス」「マルチ」をつくる
同時に複数の楽器音色を鍵盤演奏したい場合はパフォーマンスを選びます。S90 XS/S70 XSには、初期状態で384種類の
パフォーマンスが準備されています。「パフォーマンスクリエーター」機能を使うと、気に入ったボイスから素早くパフォーマ
ンスを作成できます。
コンピューターのDAWソフトウェアのマルチ音源として使いたい場合はマルチを選びます。また、USB記憶装置や内蔵フ
ラッシュメモリーに保存したMIDIファイルを再生することもできます。

好きなプログラムを組み合わせて、自分だけの「マスター」キーボードをつくる
お気に入りのプログラム(ボイス、パフォーマンス、マルチ)が決まったら、それらを集めて「マスターモード」に登録します。
よく使うプログラムをワンタッチで呼び出すことができます。
また、プログラムごとに鍵盤の領域(ゾーン)をわけられるので、まるでMIDIキーボードが複数あるかのように使用できます。

コンピューターのDAWソフトウェアをコントロールする
S90 XS/S70 XSのボタンやコントローラーを使って、対応DAWソフトウェアの音量バランス、パニング、ソングのスター
ト/ストップといった機能や、VSTインストゥルメントのパラメーターをコントロールすることもできます。マウスやキー
ボートでの入力に比べ、より直感的にソフトウェアを操作できます。

システム全体の設定をしたり、本体データをバックアップする
プログラムのサウンドは、それぞれボイスモード、パフォーマンスモード、マルチモードでエディットしますが、S90 XS/
S70 XS音源の音の高さの微調節や、MIDIの入出力にUSB TO HOST端子とMIDI端子のどちらを使うかなど、システム全体
に関わる設定は、ユーティリティーモードで設定します。
また、ファイルモードを使えば、USB記憶装置や内蔵フラッシュメモリーに本体データをバックアップできます。

S90 XS/S70 XSの基本的な使い方

ボイスを選ぶ 21ページ

音色を変化させる 23ページ

ボイスモードで気に入ったボイスから
パフォーマンスを作る
(パフォーマンスクリエーター）

28ページ

パフォーマンスを選ぶ 32ページ

外部音源として使う 38ページ

MIDIファイルを再生しながら演奏する 41ページ

用途に合わせた本体の設定を作る 43ページ

ソフトウェアをコントロールする 38ページ

本体のさまざまな設定をする 45ページ

データをセーブ/ロードする 47ページ
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ボイスモードのトップ画面にあたるボイスプレイ画面では、
さまざまなボイスから好きなものを選んで演奏できます。
ボイスには、以下の2種類があります。

ノーマルボイス
ピアノ、オルガン、ギター、シンセサイザーなどさまざまな
楽器の音色のボイスです。キーボードの鍵盤の音階に合った
音の高さで発音します。

ドラムボイス
リズムパートを演奏する場合に使う音色のボイスです。各
ノートナンバー (鍵盤)にいろいろな打楽器が割り当てられて
います。

S90 XS/S70 XSには、ボイスを記憶させるためのバンク
が用意されています。バンクの種類には、大きく分けてプリ
セットバンク、ユーザーバンク、GMバンクがあります。各
バンクは、記憶されているボイスや役割が下記のように異な
ります。

プリセットバンク
あらかじめ本体に内蔵されたボイスが入っています。
プリセットバンクには、ボイスを保存できません。

ユーザーバンク
ボイスエディットで作ったボイスを保存(ストア)しておくバ
ンクです。初期状態ではプリセットと同じボイスがメモリー
されています。

NOTE ユーザーバンクのボイスは、上書きされると消えてしまいます。
エディットしたボイスを保存する場合は、大事なユーザーボイ
スに上書き保存しないようにご注意ください。

GMバンク
GMボイスとして規定されたボイスが入っています。

ボイスモードでは、上記のバンクが全部で16個(プリセット
バンク1～8、ユーザーバンク1～4、GMバンク、プリセッ
トドラムバンク、ユーザードラムバンク、GMドラムバンク)
用意されています。各バンクには、ボイスが種類別に記憶さ
れています。ボイスプレイ画面では、これらのボイスバンク
の中から好きなボイスを選んで演奏できます。

NOTE ボイスについて詳しくは、「S90 XS/S70 XSのしくみ」をご
覧ください。ボイスの一覧は、PDFファイル「データリスト」
をご覧ください。

ボイスを選ぶ

1 [VOICE]ボタンを押します。
[VOICE]ボタンのランプが点灯し、ボイスモードのボイス
プレイ画面が表示されます。

2 BANK [DEC]/[INC]ボタンでボイスバンクを選
びます。
この時点で、鍵盤を弾くと現在画面上に表示されているボ
イスの音が出ます。
また、ボイスプレイ画面に表示されている各項目は以下の
とおりです。

● ボイスプレイ画面

● ノーマルボイスのバンクについて
PRE1～PRE8 (プリセットバンク)、GM (GMバンク)、
USR1～4 (ユーザーバンク)の13のバンクがあります。

● ドラムボイスのバンクについて
PDR (プリセットドラムバンク)、GMDR (GMドラムバン
ク)、UDR (ユーザードラムバンク)の3つのバンクがありま
す。

NOTE ユーティリティーGeneral画面の「Bank Wrap Around」
を「on」に設定すると、最後のバンクと最初のバンクを連
続して切り替えできるようになります。

3 データダイアルや[DEC]/[INC]ボタンでボイス
を選択します。

NOTE データダイアルや[DEC]/[INC]ボタンを使ってプログラム
ナンバーを増減していくと、プログラムナンバーの上限/下
限でバンクが自動的に切り替わり、異なるバンクのボイス
を次々に選択できます。

NOTE プレイ画面で[SHIFT]ボタンを押しながら[INC]ボタンを押
すと、プログラムナンバーの値が10増加します。逆に
[SHIFT]ボタンを押しながら[DEC]ボタンを押すと、プロ
グラムナンバーの値が10減少します。

4 鍵盤を弾いてみましょう。

ボイスモードで演奏する

GMボイス
GMとは、メーカーや機種が異なった音源でも、ほぼ同じ
系統の音色で演奏が再現されることを目的に設けられた、
音源の音色配列やMIDI機能に関する一定の基準のことで
す。本体のGMボイスバンクは、GM対応のソングデータ
がほぼ正常に再生できることを目的にしており、GMに完
全に対応しているわけではありません。

メインカテゴリー バンク サブカテゴリー
プログラム
ナンバー

アルペジオ
テンポ

ボイスネーム 各エフェクトの
オン（表示）/オフ（非表示）
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ボイスモードで演奏する
カテゴリーサーチを使う
S90 XS/S70 XSのボイスは、カテゴリーごとに分類され
ています。カテゴリーは、ボイスをピアノ、オルガンといっ
た楽器の種類や音のキャラクター別に分けたものです。カテ
ゴリーサーチは、特定のカテゴリーを指定して、その中から
使いたいボイスをすばやく探すことができる便利な機能で
す。

1 ボイスプレイ画面で[CATEGORY SEARCH] 
ボタンを押します。
カテゴリーサーチダイアログが表示されます。

2 カーソル[U]ボタンで、「Main (メインカテゴ
リー )」にカーソルを移動し、データダイアルを
回してメインカテゴリーを選択します。

3 カーソル[D]ボタンで、「Sub (サブカテゴリー )」
にカーソルを移動し、データダイアルを回して
サブカテゴリーを選択します。

4 [ENTER]ボタン、またはカーソル[R]ボタンを
押し、カテゴリーを確定します。
確定されたカテゴリーのボイスリストが表示されます。

5 カーソル[U]/[D]ボタンまたはデータダイアルで
ボイスを選択します。
カテゴリーを変更したい場合は、カーソル[L]ボタンまたは
[EXIT]ボタンを押して、手順2に戻ります。

6 [ENTER]ボタンを押し、ボイスを確定します。
カテゴリーサーチダイアログが閉じます。

お気に入りのボイスを集めた
カテゴリーを作る(フェーバ
リットカテゴリー )
カテゴリーサーチには、気に入ったボイスをフェーバリット
カテゴリーとして登録する機能があります。あらかじめ気に
入ったボイスをフェーバリットカテゴリーに登録しておく
と、曲作りの際に使いたいボイスをすばやく選び出すことが
できます。

気に入ったボイスをフェーバリットカテゴ
リーに登録する

1「カテゴリーサーチを使う」の手順1～4を行ない、
選択したカテゴリーのボイスリストを表示させま
す。

2 カーソル[R]ボタンを押し、フェーバリット
チェックボックス欄にカーソルを移動させます。

3 カーソル[U]/[D]を押すか、データダイアルを回
して、気に入ったボイスを選びます。

4 [ENTER]ボタンを押して、フェーバリット
チェックボックスにチェックを入れます。
チェックボックスに「×」マークが表示され、選択中のボ
イスがフェーバリットカテゴリーに登録されます。もう一
度[ENTER]ボタンを押すと、フェーバリットチェックボッ
クスのチェックが外れます。
複数のボイスを登録したい場合は、手順3～4を繰り返しま
す。

NOTE フェーバリットカテゴリーは設定直後に保存されます。

5 フェーバリットカテゴリーへの登録が済んだら、
[VOICE]ボタンを押して、ボイスプレイ画面に戻
ります。
カテゴリーサーチダイアログで選択していたボイスが表示
されます。

現在選択されているボイスをフェーバリットカテゴリーに登
録する場合は、パネルの[SHIFT]ボタンを押しながら
[FAVORITE]ボタンを押すと簡単に登録できます。お気に
入りを解除する場合も、同様に[SHIFT]ボタンを押しながら
[FAVORITE]ボタンを押します。

メインカテゴリー

サブカテゴリー

フェーバリット
チェックボックス欄

現在選択されているカテゴリーのボイスリスト

現在選択されている
メインカテゴリーとサブカテゴリー

フェーバリット
チェックボックス欄
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ボイスモードで演奏する
フェーバリットカテゴリーに登録されてい
るボイスを選ぶ

1 ボイスプレイ画面で[FAVORITE]ボタンを押し
ます。
フェーバリットカテゴリーとして登録されているボイスリ
ストが表示されます。

2 カーソル[U]/[D]ボタンまたはデータダイアルで
ボイスを選択します。

3 [ENTER]ボタンを押し、ボイスを確定します。

シンプル画面に切り替える

ボイスプレイ画面でパネルの[SHIFT]ボタンを押しながら
カーソル[L]/[R]ボタンを押すとシンプル画面に切り替わり
ます。シンプル画面では、ボイスネームを大きな文字で表示
します。文字の種類は3種類から選べます。

音色を変化させる
本体のノブ1～4を操作すると、選択中のボイスのパラメー
ターやエフェクトのかかり具合を増減することで音色を変化
させることができます。ノブにはそれぞれ5種類の機能が割
り当てられていて、ノブファンクションボタンで切り替える
ことができます。

1 ノブ1～4の左にあるノブファンクションボタンを
押して、割り当てたい機能に該当するランプを点
灯させます。
ノブセレクトポップアップが表示されます。ノブセレクト
ポップアップでは、ノブに割り当てられた機能と、その機
能の現在の値が表示されます。
[EXIT]ボタンを押すと、ポップアップが閉じます。

NOTE ユーティリティーGeneral画面の「Knb/Sldr Func Disp 
Sw (ノブ/スライダーファンクション ディスプレイ スイッ
チ)」が「off」の場合は、ノブセレクトポップアップは表
示されません。

2 鍵盤を弾きながら、本体のノブ1～4のいずれかを
回します。
ノブポップアップ画面が表示され、操作した機能が音色に
効果します。ノブポップアップ画面には、現在操作してい
るノブの機能、その機能の現在の値、「Original」の値を表
示します。「Original」の値は、ノブの機能の編集前の値(保
存されている値)を示しています。

シンプル画面1

シンプル画面2

シンプル画面3

各機能の現在の値

ノブファンクションボタン
ノブ1～4に

割り当てられている機能

編集前の値（保存されている値）

現在の値操作しているノブの機能

編集前の値（保存されている値）
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ボイスモードで演奏する
ボイスをエディットする
ボイスを構成するさまざまな設定項目(パラメーター )の値を
変更してボイスを作り変える操作をエディットといい、ボイ
スモードのサブモードであるボイスエディットで行ないます。
ボイスエディットは、ボイスの種類によってパラメーターが
異なります。

ノーマルボイスのエディット

鍵盤の音階どおりに発音する「ノーマルボイス」は、最大8
個のエレメントで構成されています。ノーマルボイスのエ
ディットは、8つのエレメントに共通のパラメーターを設定
する「コモンエディット」と、エレメントごとのパラメー
ターを設定する「エレメントエディット」の2種類に分かれ
ます。エレメントエディットに関してはS90 XS/S70 XS
エディターでのみ可能です。

NOTE エレメントレベルは、本体でエディットできます。後述の「エ
レメントレベルの調整」をご参照ください。

ドラムボイスのエディット

各鍵盤にいろいろな打楽器が割り当てられた「ドラムボイ
ス」のエディットは、全キーに共通のパラメーターを設定す
る「コモンエディット」と、キーごとのパラメーターを設定
する「キーエディット」の2種類に分かれます。キーエ
ディットに関してはS90 XS/S70 XSエディターでのみ可
能です。

エレメントレベルの調整

1 ボイスモードで[EDIT]ボタンを押します。

2 スライダーファンクションボタンを何度か押して
ランプを消灯させます。

3 ナンバー [1]～[8]ボタンでエディットしたいエレ
メントを選択します。

4 スライダーを操作してエレメントレベルを調整し
ます。
ナンバー [1]～[4]ボタンを選択した場合は、スライダーに
はエレメント1～4が、ナンバー [5]～[8]ボタンを選択した
場合は、スライダーにはエレメント5～8が設定されます。

エフェクトをかける
S90 XS/S70 XSには数多くのエフェクトが内蔵されてい
ます。このエフェクトを活用することで、ボイスにさまざま
な効果をかけられます。たとえば、プリセットボイスのエ
フェクトを変更するだけでも、まったく違ったボイスに仕上
げることができます。ここではプリセットボイスにかけるエ
フェクトタイプや設定を変更し、ユーザーボイスとして保存
する手順を説明します。

1 [VOICE]ボタンを押して、ボイスプレイモードに
入ります。

2 エフェクトを変更したいボイスを選びます。

3 [EDIT]ボタンを押します。
ボイスエディットセレクト画面が表示されます。

4 カーソルを「Effect」に移動して、[ENTER]ボ
タンを押します。
ボイスエディットエフェクト画面が表示されます。

NOTE アルペジオ/エフェクトファンクションが「EFFECT ON/
OFF」のとき、[SHIFT]ボタンを押しながら[INS]ボタンを
押すと、ボイスエディットエフェクト画面に直接移動しま
す。

エディットマークについて
プレイ画面やエディット画面でパラメーターの値を変更す
ると、画面右上に E(エディット)マークが表示されます。
この表示により、選択中のプログラムが設定を変更された
状態にあり、まだ保存されていないことを確認できます。
現在の状態を保存するには、ストア(31ページ)の操作を
行ないます。

エレメントとは?
ボイスを構成する最小単位で、それ自体をボイスとして使
用できます。
エレメントは、楽器音などの波形(ウェーブ)にさまざまな
パラメーター (エフェクト、EGなど)を付加して作られて
います。S90 XS/S70 XSの各ボイスは、エレメントを
いくつか組み合わせることによって作られています。
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ボイスモードで演奏する
5 カーソルを「InsA」に移動して、[ENTER]ボタ
ンを押します。
現在のエフェクトのパラメーターが表示されます。

6 カーソルを「Category」に移動して、データダ
イアルでカテゴリーを選択します。

7 カーソルを「Type」に移動して、データダイア
ルでエフェクトタイプを選択します。

8 カーソルを「Preset」に移動して、データダイ
アルでプリセットを選択します。
プリセットには、エフェクトがよく使われる状況に応じた
パラメーターの設定が用意されています。プリセットを変
更するだけでも、効果の違いがありますので、いくつか試
してみましょう。

9 必要に応じて各パラメーターを設定します。
エフェクトによってさまざまなパラメーターが用意されて
いますので、イメージに近い音になるまで微調整をしま
しょう。

10 作業が終わったら、[STORE]ボタンを押して
ボイスを保存します。
プリセットボイスをエディットしたときは、ユーザーボ
イスとしてユーザーバンクに保存します。

11 データダイアルで保存先を選んで[ENTER]ボ
タンを押すと確認画面が表示されるので、もう
一度[ENTER]ボタンを押します。

NOTE インサーションBのエフェクトを変更する場合も同様の手順です。
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S926

ボイスモードで演奏する
アルペジオを使う
アルペジオとは、鍵盤演奏に応じて、アルペジオ(分散和音)
を自動演奏する機能です。
アルペジオは、ライブパフォーマンスなどで演奏を補助する
ためのツールとしてだけではなく、楽曲制作などでもクオリ
ティーの高いMIDIデータを手軽に入力したり、目的の楽器
や音楽ジャンルにぴったりあったバッキングフレーズを作成
したりするツールとして活用できます。あらかじめ、音色や
フレーズに合わせてボイスごとに、最大5つまで、好きなア
ルペジオタイプを設定しておくことができます。パフォーマ
ンス/マルチモードでは、パフォーマンス/マルチのパートご
とに最大5つまでアルペジオを設定でき、同時に4パートま
でのアルペジオ設定を有効にできます。
また、アルペジオ再生させるノートリミット(キーの範囲)や
ベロシティーリミット(鍵盤を押す強さの範囲)を設定した
り、アルペジオ再生の仕方やプレイエフェクトを設定するこ
ともできます。アルペジオは外部にMIDI出力することもで
きます。

NOTE アルペジオをMIDI出力する場合の送信チャンネルは、上記の
「Arp MIDI Out Sw」と同じ画面にある「Arp Transmit Ch」
で設定します。

アルペジオの種類

S90 XS/S70 XSでは、シンセ/ピアノ/ギター /ベース/ス
トリングス/ドラムなど18種類のカテゴリー、計6,779の
アルペジオがプリセットされています。

アルペジオをオン/オフする

アルペジオをオン/オフを切り替えるには、パネルの[ARP 
ON/OFF]ボタンを押します。

アルペジオパターンを選ぶ

1 ボイスで[EDIT]ボタンを押します。

2「Arpeggio」を選択して、[ENTER]ボタンを押
します。

3 カーソルボタンで「Arp Select」を選択して、
データダイアルでArp 1～5のいずれかを選択し
ます。

4 カーソルボタンで「Arp 1～5 Type」を選択し
て[ENTER]ボタンを押します。

5 データダイアルでMain Category/Sub 
Category/Typeを変更しながら、気に入った
パターンを選択します。

6 気に入ったパターンが見つかったら、[STORE]
ボタンを押して保存します。

アルペジオを外部にMIDI出力する
以下のパラメーターをオンに設定することで、アルペジオ
のフレーズをMIDI出力できます。

● ボイスのアルペジオ
ボイスモード → [UTILITY] → ユーティリティーセレクト
画面で「Voice」を選択 → [ENTER] → ユーティリ
ティーボイスセレクト画面で「Arpeggio」を選択 → 
[ENTER] → 「Arp MIDI Out Sw」

● パフォーマンスのアルペジオ
パフォーマンスモード → [EDIT] → パフォーマンス
エディットセレクト画面でパート選択 → [ENTER] → 
パフォーマンスパートエディットセレクト画面で
「Arpeggio」を選択 → [ENTER] → Arp Select画面で
「Arp Edit」を選択 → [ENTER] →「Arp MIDI Out Sw」

● マルチのアルペジオ
マルチモード → [EDIT] → マルチエディットセレクト画
面でパート選択 → [ENTER] → マルチパートエディット
セレクト画面で「Arpeggio」を選択 → [ENTER] → Arp 
Select画面で「Arp Edit」を選択 → [ENTER] →「Arp 
MIDI Out Sw」
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ボイスモードで演奏する
選択中のアルペジオタイプを
他のアルペジオパートにコピーする

Arp 1に設定したアルペジオタイプをArp 2～5にコピーす
るには下記の手順で行ないます。

1 アルペジオ/エフェクトファンクションボタンを押
して、「ARP SELECT」を選択します。

2 ファンクションボタンの[1]を押します。

3 [STORE]ボタンを押しながらファンクションボ
タンの[2]～[5]を押します。

アルペジオを切り替える

アルペジオの5種類を切り替えるには、アルペジオ/エフェク
トファンクションボタンとファンクションボタンを使います。

1 パネルの[ARP ON/OFF]ボタンを押してアルペ
ジオをオンにします。

2 アルペジオ/エフェクトファンクションボタンを押
して「ARP SELECT」を選びます。

3 ファンクションボタンでアルペジオを切り替えます。

アルペジオ /エフェクトファンクションボタン

ファンクションボタン
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S928
S90 XS/S70 XSには、ボイスモードで気に入ったボイスを活用してパフォーマンスを作れる「パフォーマンスクリエー
ター」という機能があります。ボイスに設定されているエフェクトなどもパフォーマンスにコピーされますので、ボイスの雰
囲気をそのまま活かしたパフォーマンスを簡単に作れます。
パフォーマンスクリエーターには、「レイヤー」「スプリット」「ドラムアサイン」の3つが用意
されています。

ボイスを重ねる(レイヤー )
ボイスを重ねる「レイヤー」を行なってパフォーマンスを
作ります。たとえば、ピアノにストリングスが重なった
パフォーマンスを作るときに便利です。

1 ボイスモードでボイスを選択します。

2 パネルの[LAYER]ボタンを押します。
カテゴリーサーチ画面が表示されます。

3 重ねたい音色のカテゴリーを選択して、カーソル
[R]ボタンを押します。
ボイスのリストが表示されます。

4 リストから重ねたい音色を選択して[ENTER]ボ
タンを押します。
パフォーマンスプレイ画面が表示されます。

5 [STORE]ボタンを押して、必要に応じて
パフォーマンスを保存します。

NOTE ストア画面の表示中に[EDIT]ボタンを押すと、ストア先の
パフォーマンスを試聴できます。

ボイスモードで気に入ったボイスからパフォーマンスを
作る(パフォーマンスクリエーター）
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ボイスモードで気に入ったボイスからパフォーマンスを作る(パフォーマンスクリエーター）
ボイスを組み合わせる(スプリット)
複数のボイスを組み合わせる「スプリット」を行なって
パフォーマンスを作ります。たとえば、左手パートはベース
で、右手パートはピアノといった左右で違うボイスを鳴らす
パフォーマンスを作るのに便利です。

1 ボイスモードでボイスを選択します。

2 パネルの[SPLIT]ボタンを押します。
スプリット画面が表示されます。

3「SPLIT POINT」にカーソルを移動して、スプ
リットボイスの境目を設定します。

[SHIFT]ボタンを押しながら鍵盤を押すと、押した鍵盤がス
プリットポイントになります。

NOTE スプリットボイスの境目に設定したノートは、上の鍵域
(UPPER)に含まれます。

4「LO/UP」にカーソルを移動して、組み合わせた
いボイスを現在のボイスの下の鍵域に設定するか、
上の鍵域に設定するか、を選択します。

NOTE 元のボイスがドラムボイスの場合、LO/UPの設定にかかわ
らず、ドラムボイスのスプリットポイントは変更されませ
ん。

5「Main」/「Sub」にカーソルを移動して、組み
合わせたいボイスのカテゴリーを選択します。

6 カーソル[R]ボタンを押します。
ボイスのリストが表示されます。

7 リストから組み合わせたい音色を選択して
[ENTER]ボタンを押します。
パフォーマンスプレイ画面が表示されます。

8 [STORE]ボタンを押して、必要に応じて
パフォーマンスを保存します。
S90 XS/S70 XS 取扱説明書 29



S930

ボイスモードで気に入ったボイスからパフォーマンスを作る(パフォーマンスクリエーター）
現在のボイスにドラムパートを
重ねる(ドラムアサイン)
鍵盤を弾くと、ドラムパターンがアルペジオで同時に演奏さ
れるパフォーマンスを作ります。

1 ボイスモードでボイスを選択します。

2 パネルの[DRUM ASSIGN]ボタンを押します。
ドラムアサイン画面が表示されます。カテゴリーにはDr/
Pc (ドラム/パーカッション)が自動的に割り当てられます。
ドラムボイスがパート4に設定され、アルペジオが自動的に
オンになります。鍵盤を押すとアルペジオがスタートしま
す。

3 カーソル[R]ボタンを押します。
ボイスのリストが表示されます。

4 リストから組み合わせたいドラム音色を選択して
[ENTER]ボタンを押します。
パフォーマンスプレイ画面が表示されます。

ドラムのアルペジオパターンを
変更する
パフォーマンスクリエーターでドラムアサインを行なった場
合、ドラムボイスはパフォーマンスのパート4に自動的に設
定され、アルペジオがオンになります。ドラムのアルペジオ
パターンを変更するときは、パフォーマンスエディットの
パートエディットを行ないます。

5 パフォーマンスプレイ画面が表示された状態で
[EDIT]ボタンを押します。
パフォーマンスエディットセレクト画面が表示されます。

6 カーソルボタンでパート4を選択して[ENTER]ボ
タンを押します。

7 カーソルボタンで「Arpeggio」を選択して
[ENTER]ボタンを押します。

8 カーソルボタンで「Arp 1 Type」を選択して
[ENTER]ボタンを押します。
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ボイスモードで気に入ったボイスからパフォーマンスを作る(パフォーマンスクリエーター）
9「Main Ctgry/Sub Ctgry/Type」をデータダ
イアルで変更しながら、気に入ったパターンを選
択します。

同様の手順で、Arp 2～5のパターンも変更できます。アル
ペジオ1～5の切り替えは、ファンクションボタンで行なう
と便利です。アルペジオ/エフェクト ファンクションボタン
を押して「ARP SELECT」を点灯させ、ファンクションボ
タンを押してください。

パフォーマンスに名前をつけて
保存する
パフォーマンスクリエーターを使ってパフォーマンスを作っ
たときに限らず、通常の操作で新規にボイスやパフォーマン
スを作ったときは、そのボイス/パフォーマンスに名前をつ
けて、ユーザーバンクに保存します。

1 パフォーマンスプレイ画面が表示された状態で
[EDIT]ボタンを押します。
パフォーマンスエディットセレクト画面が表示されます。

2 カーソルボタンで「Common」を選択して
[ENTER]ボタンを押します。

3 カーソルボタンで「Name」を選択して
[ENTER]ボタンを押します。

4「Name」が選択された状態で[ENTER]ボタンを
押します。
ネーミングダイアログ画面が表示されます。

5 データダイアルとカーソルボタンで文字を選び、
[INC]ボタンで決定します。文字を間違えて選ん
だときは[DEC]ボタンで戻ります。
最大20文字まで入力できます。

6 文字の入力が終わったら[ENTER]ボタンで確定
します。

7 [STORE]ボタンを押します。
保存先のユーザーバンクとプログラムが表示されます。

8 保存したいバンクとプログラムを選択して、
[ENTER]ボタンを押します。

NOTE ストア画面の表示中に[EDIT]ボタンを押すと、ストア先の
ボイス/パフォーマンス/マルチを試聴できます。

9 確認のダイアログが表示されますので、もう一度
[ENTER]ボタンを押します。

アルペジオ /エフェクトファンクションボタン

ファンクションボタン
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パフォーマンスを選ぶ
パフォーマンスは、ボイスと同じ方法で選択できます。カテゴリーサーチや画面表示もボイスと同じなので、ボイスモードで
の手順を思い出しながら操作してみましょう。ただし、パフォーマンスではプリセットバンクやドラムバンクは無く、使える
のはユーザー1～4バンクだけになります。

音色を変化させる
ボイスモードと同様に、パフォーマンスモードでもノブやスライダーを使って音色を変化させることができますが、ひとつの
パフォーマンスは、最大4つのボイスが組み合わさってできています。そのため、パフォーマンス全体に影響する変化のさせ
方と、パフォーマンスを構成する特定のボイスに影響する変化のさせ方とがあります。変化させるパートの選択は、パフォー
マンスコントロールボタン群で行ないます。パフォーマンス全体を変化させるには[COMMON]ボタンを押してからノブを動
かします。個別のボイスを変化させるには[PART SELECT]ボタンでパートを選択してからノブを動かします。

NOTE [SHIFT]ボタンを押しながら[COMMON]/[PART SELECT]ボタンを押すと、コモンエディットセレクト画面/パートエディットセレクト画面
が表示されます。パフォーマンスエディットを行なうときに便利な機能です。

スライダーを使うと、パフォーマンスを構成する各パートのボリューム、パン、コーラスセンド、リバーブセンドを調節でき
ます。スライダーファンクションボタンで機能を選択して、スライダーを操作します。

パフォーマンスモードで演奏する

パフォーマンス全体を選択 パートを選択

スライダーファンクション
ボタンで機能を選択
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S90 XS/S70 XSのリアパネルにはMIC INPUT (マイク入力)端子があり、マイクを接続して弾き語り演奏やMCマイクとし
て活用できます。MIC INPUT端子からの信号には本体内蔵のエフェクトをかけられるほか、ボコーダーエフェクトの入力とし
ても使用します。ここでは、マイクを接続して演奏しながら歌う場合を例として説明します。

1 リアパネルのMIC INPUT (マイク入力)端子にマイクを接続します。

2 パネルの[MIC ON/OFF]ボタンを押してマイク入力をオン(ランプが点灯)にします。

3 INPUT GAINノブを右に回して、入力ゲインを調節します。
最も大きな音を入力したときに、PEAKランプが一瞬光る程度に入力ゲインを調節します。

4 ノブファンクションボタンを押して「MIC」を選択してVOLUMEがアサインされたノブで音量を調節します。

5 必要に応じてPANやCHORUS SEND、REVERB SENDがアサインされたノブで各パラメーターを調節
します。

マイクを接続して演奏しながら歌う
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本体での演奏をUSB記憶装置にオーディオファイルとして録音するには、オーディオレコード/プレイモードを使用します。
オーディオレコード/プレイモードでは、本体での演奏をUSBストレージや内蔵フラッシュメモリーの最上位の階層にオー
ディオファイルとして録音したり、指定したストレージのオーディオファイルを再生したりすることができます。

録音する
本体での演奏を44.1kHz/16bit/ステレオのWaveファイ
ルとして録音します。録音時の録音レベルは固定で、連続で
最大74分の録音ができます。ここでは、USB記憶装置に録
音する手順を説明します。

1 [AUDIO REC/PLAY]ボタンを押します。
オーディオレコード/プレイ選択画面が表示されます。

2 「Rec」を選択して、[ENTER]ボタンを押します。
スタンバイ画面が表示されます。

3「Rec Storage」にカーソルを合わせて、データ
ダイアルや[DEC]/[INC]ボタンを押してUSB記
憶装置(例ではusb1-1)を選択します。

NOTE 内蔵フラッシュメモリーは「internal」と表示されます。

4「Trigger Level」にカーソルを合わせて、トリ
ガーレベルを設定します。
トリガーレベルは、鍵盤演奏の強さやマイク入力の音量で
録音を開始するレベルを設定します。ノイズに影響されな
い範囲でできるだけ低く設定すると、アタック部分が切れ
ずに録音できます。ここでは例として、トリガーレベルを
「10」に設定します。

5 [ENTER]ボタンを押します。
録音待機画面が表示されます。

6 鍵盤を演奏します。
手順4で設定したトリガーレベルを超える鍵盤演奏をすると
録音が始まります。

7 演奏が終わったら[ENTER]ボタンを押します。

8「Save Audio Rec File?」（オーディオ録音
ファイルを保存しますか？）と尋ねるダイアログ
が表示されますので、[ENTER]ボタンを押しま
す。
USB記憶装置の最上位のディレクトリーに演奏を録音した
オーディオファイルが保存されます。
画面上にはオーディオプレイ画面が表示されます。

演奏をUSB記憶装置に録音する/再生する
(オーディオレコード/プレイモード)
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演奏をUSB記憶装置に録音する/再生する (オーディオレコード/プレイモード)
再生する
録音したオーディオファイルを再生してみましょう。

1 オーディオプレイ画面で、録音したデータのうち、
再生したいデータをカーソルボタン[U]/[D]ボタ
ンで選択します。
オーディオファイルの名前は、連番で000.wav、
001.wav…という具合に自動的につけられます。

2 [ENTER]ボタンを押します。
オーディオファイルの再生が始まります。

3 データダイアルや[DEC]/[INC]ボタンで再生音
量を調節します。

4 [ENTER]ボタンを押して停止します。
ここでもう一度[ENTER]ボタンを押すと、停止したところ
から引き続き再生します。

5 [EXIT]ボタンを押すと、ファイルを選択する画面
に戻ります。

6 新規に録音する場合は、[SHIFT]ボタンを押しな
がら[AUDIO REC/PLAY]ボタンを押します。
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S90 XS/S70 XSは、コンピューターと接続することで下記のようなことができます。
● DAWソフトウェアの外部音源やMIDIキーボードとしての活用
● DAWソフトウェアのリモートコントロール
● S90 XS/S70 XSエディターを使った詳細なボイスエディット

コンピューターとの接続
S90 XS/S70 XSをコンピューターと接続するためには、
USBケーブルとUSB-MIDIドライバーが必要です。次の手
順で操作してください。送受信できるデータは、MIDIデー
タのみです。

NOTE 音を鳴らすには、本体にスピーカーやヘッドフォンを接続する
必要があります。詳しくは、「ご使用前の準備」(16ページ)を
ご覧ください。

1 以下のURLから、最新のUSB-MIDIドライバー
をダウンロードします。
ダウンロードボタンを押したあと、ファイルの実行および
解凍をします。
http://www.yamaha.co.jp/download/usb_midi/

NOTE 動作環境については、上記URLをご覧ください。

NOTE USB-MIDIドライバーは、改良のため予告なしにバージョ
ンアップすることがあります。詳細および最新情報につい
ては、上記URLをご確認ください。

2 USB-MIDIドライバーをコンピューターにインス
トールします。
ダウンロードしたファイルに付属されているインストール
ガイドをご覧ください。
手順の中の、PA機器/電子楽器のUSB TO HOST端子を
USBケーブルで接続する箇所については、下図を参考にし
てください。

3 本体を、USB TO HOST端子を通してMIDIを送
受信する状態に切り替えます。
[UTILITY]ボタンを押してユーティリティーモードに入り、
カーソルボタンで「MIDI」を選んで[ENTER]ボタンを押
し、MIDI画面を表示します。MIDIインアウトを「USB」に
設定します。

4 [STORE]ボタンを押して、本体に保存します。

コンピューターと接続して使う

USB TO HOST端子USB端子

USBケーブル

リアパネル
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コンピューターと接続して使う
USB TO HOST端子ご使用時の注意
USB TO HOST端子でコンピューターと接続するとき
は、以下のことを行なってください。
以下のことを行なわないと、コンピューターや本体が
停止(ハングアップ)して、データが壊れたり、失われ
たりするおそれがあります。コンピューターや本体が
停止したときは、電源を入れ直し、コンピューターを
再起動してください。
• USB TO HOST端子でコンピューターと接続する前に、
コンピューターの省電力(サスペンド/スリープ/スタン
バイ/休止)モードを解除してください。

• 本体の電源を入れる前に、USB TO HOST端子とコン
ピューターを接続してください。

• 本体の電源オン/オフやUSBケーブルの抜き差しをする
前に、以下のことを行なってください。
• すべてのアプリケーション(S90 XS/S70 XSエディ
ター、シーケンサーなど)を終了させてください。

• 本体からデータが送信されていないか確認してくださ
い。（鍵盤を演奏したりソングを再生させたりしても、
本体からデータが送信されます。）

• 本体の電源オン/オフやUSBケーブルの抜き差しは、6
秒以上間隔を空けて行なってください。

MIDIチャンネルとMIDIポート
MIDIチャンネルは「16」までしか規定されていません
が、16チャンネルを超えるソングデータを扱えるように
するための概念として「MIDIポート」があり、1ポートあ
たり16チャンネルを扱えるようになっています。MIDI
ケーブルでは同時に1ポート分(16チャンネル分)のデータ
しか通信できませんが、USBケーブルでは最大8ポート分 
(16×8=128チャンネル分)のMIDIデータを扱えます。
またS90 XS/S70 XSでは、USB端子を使って接続する
場合、扱えるポートが5つの用途によって、下記のとおり
固定で決まっています。

ポート1
S90 XS/S70 XSの音源部が扱えるポートです。外部
MIDI機器やコンピューターからS90 XS/S70 XSの音源
部を鳴らしたい場合は、外部MIDI機器やコンピューター
側でポート1に設定する必要があります。

ポート2
S90 XS/S70 XSと接続されたコンピューター上の
DAWソフトウェアを、リモート操作するときに使われる
ポートです。

ポート3
S90 XS/S70 XSが受信したMIDIデータを、別のMIDI
機器にそのまま転送する(スルーさせる)場合に使われる
ポートです。
S90 XS/S70 XSでは、USB TO HOST経由で受信した
MIDIポート3のデータは、MIDI OUT端子からスルーさ
れ、MIDI IN端子経由で受信したMIDIデータは、MIDIポー
ト3のデータとしてUSB TO HOST端子からスルーされ
ます。

ポート4
S90 XS/S70 XSエディターが通信をする専用のポート
です。他の機器やソフトウェアでは使用しません。

ポート5
S90 XS/S70 XSリモートエディターが通信をする専用
のポートです。他の機器やソフトウェアでは使用しませ
ん。

S90 XS/S70 XSとコンピューター間で、USBケーブル
を使ってMIDI送受信をする場合、MIDIチャンネルだけで
なく、MIDIポートも送信側と受信側で合わせる必要があ
ります。上記用途に合わせて、外部機器側のポートの設定
を行なってください。
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コンピューターと接続して使う
外部音源として使う(マルチモード)
本体を、DAWソフトウェアのMIDIマルチ音源として利用す
る方法です。コンピューターに負荷をかけずに、クオリ
ティーの高いMIDI音源として利用できます。

1 [MULTI/SEQ PLAY]ボタンを押してマルチ
モードに入ります。

2 エディットしてもよいマルチを選びます。

3 [MIXING]ボタンを押して、ミキシング画面に入
ります。

4 曲に合わせてパート1～16のミキシングを設定し
ます。
ミキシング画面では、ボイスの選択、パン、ボリューム、
コーラス/リバーブとドライ音のバランス、インサーション
エフェクトのオン/オフ、アルペジオのオン/オフを設定で
きます。さらに細かいボイスのエディットは、マルチパー
トエディット画面で行ないます。

1 S90 XS/S70 XSの音を鳴らすトラックは、
MIDI出力ポートをUSBポート1に設定します。
USBケーブルで接続している場合は「Yamaha S90 
XS(S70 XS)-1」または「YAMAHA S90 XS(S70XS) 
Port1」に設定します。

2 各トラックにMIDIデータを入力します。
各MIDIトラックに対応した音源の設定は、S90 XS/S70 
XS側のミキシングモードで行ないます。

NOTE 後述するS90 XS/S70 XSエディターを使うと、コン
ピューター側からS90 XS/S70 XSのミキシングを設定で
きます。さらに、ミキシングの設定をファイルで保存して
おき、いつでも再現できます。

ソフトウェアをコントロールする
(リモートモード)
S90 XS/S70 XSには、パネル操作でコンピューター上の
DAWソフトウェアやソフトウェア音源をコントロールでき
るリモートコントロール機能が搭載されています。パネル上
のファンクションボタン(プレイ、ストップボタンなど)、
ノブやスライダーなどを活用することで、通常マウスやキー
ボードを使って行なう操作をリアルタイムでコントロールで
き、ストレスのないスムーズな音楽制作を実現します。
リモート機能では、Cubase、Logic、SONAR、Digital 
Performerの4種類のDAWソフトウェアをコントロールで
きます。また、VSTインストゥルメントのコントロールテ
ンプレートを最大50種類本体に保存できます。コントロー
ルテンプレートの編集は、S90 XS/S70 XSリモートエ
ディターを使用します。

NOTE S90 XS/S70 XSリモートエディターは「S90 XS/S70 XS 
Remote Tools」をインストールすることでインストールされ
ます。S90 XS/S70 XS Remote Toolsには、S90 XS/
S70 XSリモートエディターと、「S90 XS/S70 XS 
Extension」(Cubaseシリーズとの連携機能を実現するソフト
ウェア)とで構成されています。

ここでは、S90 XS/S70 XSからDAWソフトウェアをコ
ントロールする方法を説明します。

本体からリモートコントロールできる
ソフトウェア

Cubase、SONAR、Logic Pro、Digital Performer

S90 XS/S70 XS側の設定

DAWソフトウェア側の設定

S90 XS/S70 XS Remote Toolsは弊社ウェブサイトか
らダウンロードできます。
http://www.yamaha.co.jp/product/syndtm/dl/

最新の情報は、下記URLをご覧ください。
http://www.yamaha.co.jp/product/syndtm/
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コンピューターと接続して使う
リモート機能の準備

NOTE 各設定の前に、お使いのコンピューターにUSB-MIDIドライ
バーとS90 XS/S70 XS Remote Toolsをインストールして
ください。

1 S90 XS/S70 XSとコンピューターをUSB
ケーブルで接続します(36ページ)。

2 [DAW REMOTE]ボタンを押して、リモート
モードに入ります。

3 [UTILITY]ボタンを押して、ユーティリティー
モードのリモート画面を表示します。

4「DAW Select」をお使いのDAWソフトウェア
に設定します。

5 [STORE]ボタンを押して、本体に保存します。

6 接続したコンピューター上のDAWソフトウェア
を起動します。

DAWソフトウェアごとに設定方法を説明します。

NOTE WindowsでDAWソフトウェアをご使用の場合、コンピューター
とS90 XS/S70 XSの接続が切れると、接続をやり直してもコ
ンピューターはS90 XS/S70 XSを認識しません。このような
場合、接続をやり直したあと、DAWを再起動してください。

Cubase
S90 XS/S70 XS Remote Toolsをインストールすると、
自動的に設定が完了します。

SONAR

1 SONARのメニューから[オプション] → [MIDI デバ
イス]でMIDI Devicesウィンドウを開きます。

2 「入力デバイス」に「Yamaha S90 XS(S70 XS)-
2」を加え、「出力デバイス」に「Yamaha S90 
XS(S70 XS)-2」を加えます。

3 SONARのメニューから[オプション] → [コントロー
ルサーフェス]でControl Surfacesウィンドウを開
きます。

4 [+]ボタンをクリックして、[コントロールサーフェス]
で「Mackie Control」を選択し、入力ポートを
「Yamaha S90 XS(S70 XS)-2」に設定し、出力
ポートを「Yamaha S90 XS(S70 XS)-2」に設定
します。

Digital Performer

1 あらかじめコンピューター (Macintosh)のAudio/
MIDI設定で、S90 XS/S70 XSのインターフェー
ス側のポート2と、音源側のポート2を接続しておき
ます。音源側のポートが1つの場合は、音源側に新規
ポートを追加して、インターフェースと接続してく
ださい。

2 Digital Performerのメニューから[Setup] → 
[ControlSurface Setup]でControl Surfaceウィン
ドウを開きます。

3 [+]ボタンを押します。

4 Driverの欄で「Mackie Control」を選びます。

5「Unit」と「MIDI」を選択する欄が開くので、
「Unit」で「Mackie Control」を選択し、「MIDI」
で「S90 XS(S70 XS)新規ポート2」を選びます。

Logic Pro

1 Logic Proのメニューから[環境設定] → [コントロー
ルサーフェス] → [設定]を選択して、設定画面を開き
ます。

2 メニューの[新規] → [インストール]を選択します。

3 モデルリストから、「Mackie Control」を選択して
追加します。

4 出力ポートに「YAMAHA S90XS Port2」を設定
します。

5 入力ポートに「YAMAHA S90XS Port2」を設定
します。

NOTE Mackie Controlは、Mackie Designs Inc.の商標です。

NOTE 主なボタン操作や機能の詳細については、別PDFファイル
「リファレンスマニュアル」をご参照ください。

S90 XS/S70 XS側の設定

DAWソフトウェア側の設定
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コンピューターと接続して使う
コントロールテンプレートを編集する

コントロールテンプレートを編集するには、S90 XS/S70 
XSリモートエディターを使用します。

ボイスをさらに細かく編集する
(エディターについて)

S90 XS/S70 XSエディターとは

S90 XS/S70 XSエディターは、S90 XS/S70 XSをマ
ルチ音源(マルチモード時)として使用する場合に、ミキシン
グパートエディットやミキシングボイスの作成を、コン
ピューター画面を使って視覚的に確認しながら行なえるユー
ティリティーソフトウェアです。S90 XS/S70 XSエディ
ターとS90 XS/S70 XSは双方向制御可能であり、S90 
XS/S70 XSをエディットすると、S90 XS/S70 XSエ
ディターも同期して変更されるので、ストレスの無いスムー
ズな操作が可能です。

Cubase上でS90 XS/S70 XSエディターを使
用する
S90 XS/S70 XSエディターは、Cubase上ではVST3プ
ラグインとして動作します。S90 XS/S70 XSエディター
を使うためには、他のVSTインストゥルメントと同じ操作
で起動します。

スタンドアローン エディターとして使用する
S90 XS/S70 XSエディターは、Studio Manager V2を
ホストアプリケーションとして、スタンドアローンで動作す
るバージョンも用意されています。Studio Manager V2
は、複数のハードウェアエディターを一元管理するソフト
ウェアです。S90 XS/S70 XSエディターを使うために
は、まずStudio Managerを起動し、Studio Managerの
プラグインとして、S90 XS/S70 XSエディターを起動し
ます。

S90 XS/S70 XS リモートエディターは、以下のURLか
らダウンロードしてお使いください。
http://www.yamaha.co.jp/product/syndtm/dl/

操作方法などについては、S90 XS/S70 XSリモートエ
ディターに付属のPDFマニュアルをご覧ください。

S90 XS/S70 XSエディターを使用する

S90 XS/S70 XSエディター、Studio Managerは、
以下のURLからダウンロードしてお使いください。
http://www.yamaha.co.jp/product/syndtm/dl/

操作方法などについては、S90 XS/S70 XSエディター、
Studio Managerに付属のPDFマニュアルをご覧ください。
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あらかじめ用意したMIDIファイルの演奏に合わせて演奏する場合はマルチモード/シーケンスプレイモードを使用します。
S90 XS/S70 XSには16トラックの再生用シーケンサーが内蔵されていますので、16トラック以内のMIDIデータであれば
再生できます。
事前にDAWソフトウェアなどでMIDIファイルの作成をして、USB記憶装置などに保存します。また、MIDIファイルを再生す
るためのマルチを作成しておくとよいでしょう。

1 MIDIファイルを保存したUSB記憶装置を、リア
パネルのUSB TO DEVICE端子に接続します。

2 パネルの[MULTI/SEQ PLAY]ボタンを何度か
押して、シーケンスプレイモードに入ります。

3 チェーンステップ1を選んで、データダイアルや
[DEC]/[INC]ボタンで、MIDIファイルの再生に
使うマルチを選びます。

4 カーソル[D]ボタンでチェーンステップ2を選ん
で、[ENTER]ボタンを押します。
ファイルロード画面が表示されます。

5 USB記憶装置のパス(ここではusb1-1)を選んで
[ENTER]ボタンを押します。

6 再生したいMIDIファイルを選んで[ENTER]ボタ
ンを押します。

7 シーケンスチェーンステップナンバーを選択する
画面が出ますので、そのまま[ENTER]ボタンを
押します。

8 確認画面が出ますのでもう一度[ENTER]ボタン
を押します。

MIDIファイルを再生しながら演奏する
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MIDIファイルを再生しながら演奏する
9 [EXIT]ボタンを何度か押して、シーケンスプレイ
画面に戻ります。

オーディオファイルの登録も同様の操作で可能です。

10 カーソル[D]ボタンでチェーンステップ3を選ん
で、データダイアルや[DEC]/[INC]ボタンで、
「end」を選びます。

11 [1]～[16]ボタンで、演奏に使用するパートを
選びます。

12 カーソル[U]ボタンでチェーンステップ1を選ん
で、[START/STOP]ボタンを押します。
演奏に使用するマルチが選択され、MIDIファイルの演奏
が始まります。

13 鍵盤で演奏をします。
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マスターモードの主な特長は、以下の2つです。
● ボイス、パフォーマンス、マルチの組み合わせを128種類保存し、呼び出すことができる
● 1つのマスタープログラムにつき4ゾーンのマスターキーボード機能を設定することができる

マスタープログラムには、ボイス、パフォーマンス、マルチの各モードで作ったプログラムの中から必要なものを登録できる
ので、マスタープログラムを切り替えることで、モードをまたぐ音色を瞬時に切り替えることができます。同時に外部MIDI機
器をコントロールするための設定も同時に切り替えることができますので、たとえば、ライブステージなどで、パフォーマン
スを演奏しながら、多数の外部MIDI音源を次々に切り替えて演奏する、といったことが可能になります。

ボイス/パフォーマンス/マルチ
を保存する
ライブのときに、曲に合わせてボイスやパフォーマンスを瞬
時に切り替えたいときは、マスタープログラムの001にボ
イス、002にパフォーマンス、というように並べて保存し
ておくと便利です。プログラムの保存は以下の手順で操作し
ます。

1 [MASTER]ボタンを押してマスターモードに入
ります。

2 エディットしたいマスタープログラムを選びます。
マスタープレイ画面が表示されます。

3 [EDIT]ボタンを押します。
マスターエディットセレクト画面が表示されます。

4 「Common」を選んで[ENTER]ボタンを押します。
コモンエディットセレクト画面が表示されます。

5 カーソルボタンで「Memory」を選んで
[ENTER]ボタンを押します。
コモンメモリー画面が表示されます。

6「Mode」で、「voice/performance/multi」
のいずれかを選びます。

7「Bank」「Number」で登録したいプログラムを
選びます。

8 [STORE]ボタンを押して保存します。

マスターキーボード機能の設定
をする
外部MIDI音源を複数使用するときは、マスターキーボード
機能を設定してマスタープログラムに保存しておくと便利で
す。マスタープログラムを切り替えたと同時に、外部MIDI
音源のプログラムを変更することもできます。基本的な操作
手順は以下のとおりです。

1 [MASTER]ボタンを押してマスターモードに入
ります。

2 エディットしたいマスタープログラムを選びます。

3 [EDIT]ボタンを押します。
マスターエディットセレクト画面が表示されます。

4 「Common」を選んで[ENTER]ボタンを押します。
コモンエディットセレクト画面が表示されます。

マスターキーボードとして使う(マスターモード)
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マスターキーボードとして使う(マスターモード)
5 「Zone Sw」を選んで[ENTER]ボタンを押します。
コモンゾーンスイッチ画面が表示されます。

6「Zone Switch」を「on」にします。
「Knob/Slider」も自動的にオンになります。

NOTE ノブやスライダーを、ノブファンクション/スライダーファ
ンクションで使う場合は、「Knob/Slider」を「off」にし
てください。

7 [EXIT]ボタンを2回押して、マスターエディット
セレクト画面に戻ります。

8 カーソルボタンで「Zone 1」を選んで
[ENTER]ボタンを押します。
ゾーンエディットセレクト画面が表示されます。

9 Transmit、Note、Preset、Knb/Sldrの各
画面でZone 1に対する設定を行ないます。

トランスミット画面

ノート画面

プリセット画面

ノブ/スライダー画面

10 [EXIT]ボタンでマスターエディットセレクト画
面に戻り、他のZoneも同様に設定します。

11 すべての設定が終わったら[STORE]ボタンを
押してマスタープログラムを保存します。

これらの設定が終わったら、マスターコモンエディット画面
の「Name」で、マスタープログラムに名前をつけておき
ましょう。名前をつけたあとも[STORE]ボタンを押して保
存してください。
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ユーティリティーモードでは、システム全体に共通した設定を行ないます。他のモードから[UTILITY]ボタンを押すとユー
ティリティーモードに入ります。[EXIT]ボタンを押すと元のモードに戻ります。
ここでは、ユーティリティーモードのうち、よく使われる機能をご紹介します。

電源を入れたときのモードを設定する

General → Power on Mode
電源を入れたときに、起動するモードをボイス/パフォーマ
ンス/マルチ/マスターから選べます。

LCDの表示を反転させる

General → LCD Mode
LCDの表示を反転できます。

クリック(メトロノーム)の設定を変更する

General → Click Sw ～ OutputSel
クリック(メトロノーム)のテンポやボリューム、出力先など
を設定します。

マイクロチューニングを設定する

MicroTune
キーごとのチューニングを変更できます。

MIC INPUT (マイク入力)端子からの信
号のエフェクトを設定する

Voice → A/D FX
MIC INPUT (マイク入力)端子からの信号にかけるエフェク
トを設定したり、ボコーダーの設定をしたりできます。

NOTE インサーションエフェクトのかけ方は24ページをご参照くださ
い。

ボイスモードでマスターエフェクト/マス
ターEQを設定する

Voice → Master FX、Master EQ
マスター出力にかかるエフェクトやEQを設定します。

本体のさまざまな設定をする(ユーティリティーモード)

normal のとき

reverse のとき
S90 XS/S70 XS 取扱説明書 45



S946

本体のさまざまな設定をする(ユーティリティーモード)
パネルロックの設定を変更する

Panel Lock
パネルの[PANEL LOCK]ボタンを押したときに操作を無効
にするボタンを設定します。チェックをはずすと、パネル
ロックがオンの状態でも、その項目の操作ができるようにな
ります。

クイックセットアップ

Quick Set
パフォーマンス/マルチモードの外部接続に関するパラメー
ターの設定を、プリセットの中から選ぶだけで定められた設
定に一度に変更できます。いくつかの設定画面にまたがった
パラメーターを、クイックセットナンバーを変更すること
で、目的に合わせて一度に設定できます。クイックセット
アップナンバーの初期設定と用途の説明は下記のとおりで
す。

クイックセット
アップナンバー

説明

1 DAWソフトウェアに、アルペジオ以外の演奏を録
音する場合の設定です。

2 DAWソフトウェアにアルペジオも含めた演奏を録
音する場合の設定です。

3 DAWソフトウェアと組み合わせて使用せず、S90 
XS/S70 XS単体で使用する場合の設定です。
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本体で設定したボイスやパフォーマンスなどをセーブ/ロードするときは、ファイルモードを使用します。他のモードから
[FILE]ボタンを押すとファイルモードに入ります。
ここでは、S90 XS/S70 XSのユーザーメモリー上のデータをすべて保存するAllデータ(拡張子.X2A)のセーブとロードを例
にして、操作を説明します。

本体の設定をUSB記憶装置に
セーブする

1 USB記憶装置を本体のUSB TO DEVICE端子に
接続します。

2 [FILE]ボタンを押してファイルモードに入りま
す。
ファイルセレクト画面が表示されます。

3 カーソルボタンで「Save」を選んで[ENTER]
ボタンを押します。
ファイルセーブ画面に内蔵フラッシュメモリーとUSB記憶
装置が表示されます。

4 カーソル[U]/[D]ボタンでUSB記憶装置を選ん
で[ENTER]ボタンを押します。
USB記憶装置のルートディレクトリーが表示されます。

5 ファイルをセーブしたいディレクトリーを選んで
[ENTER]ボタンを押します。
そのディレクトリーにファイルをセーブする場合は、
「NEW FILE」にカーソルを合わせて[ENTER]ボタンを押し
ます。
ファイルの形式を選択する画面が表示されます。

6 ファイルタイプを選んで[ENTER]ボタンを押し
ます。
すべてのデータを保存するときは「All」を選びます。Allで
保存したデータは、ロードするときにロードしたい内容を
選ぶことができるので便利です。

7 ファイル名をつけて[ENTER]ボタンを押します。
データダイアルとカーソルボタンで文字を選び、[INC]ボタ
ンで決定します。文字を間違えて選んだときは[DEC]ボタ
ンで戻ります。

8 確認画面が表示されますので、[ENTER]ボタン
を押します。
ファイルがセーブされます。

本体の設定をセーブ/ロードする(ファイルモード)
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本体の設定をセーブ/ロードする(ファイルモード)
USB記憶装置にセーブした本体
の設定をロードする

1 USB記憶装置を本体のUSB TO DEVICE端子に
接続します。

2 [FILE]ボタンを押してファイルモードに入ります。
ファイルセレクト画面が表示されます。

3 カーソルボタンで「Load」を選んで[ENTER]ボ
タンを押します。
ファイルロード画面に内蔵フラッシュメモリーとUSB記憶
装置が表示されます。

4 カーソル[U]/[D]ボタンでUSB記憶装置を選ん
で[ENTER]ボタンを押します。
USB記憶装置のルートディレクトリーが表示されます。

USB記憶装置内に、フォルダー階層がある場合は、カーソ
ル[R]ボタンでフォルダー内に移動します。

5 拡張子「.X2A」ファイルを選んで[ENTER]ボタ
ンを押します。
Allデータの場合はロードできるファイルの種類が表示され
ます。

6 ロードしたい内容を選んで[ENTER]ボタンを押
します。
ボイス/パフォーマンスをロードする場合、すべてのボイス
/パフォーマンスをまとめてロードするときは、Voice/
Performanceを選択して[ENTER]ボタンを押します。個
別にロードするときは、カーソル[R]ボタンでバンクごと、
ボイス/パフォーマンスごとを選択できます。

7 確認画面が表示されますので、[ENTER]ボタン
を押します。
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本体の設定をセーブ/ロードする(ファイルモード)
USB記憶装置(デバイス)について
接続例

ご利用いただけるUSB機器
USB TO DEVICE端子に接続できるUSB機器は、ハード
ディスクドライブ、CD-ROMドライブ、フラッシュディス
ク、MOドライブなどの記憶装置1台だけです。その他の機
器(マウス、コンピューターのキーボードなど)は接続しても
使えません。バスパワー機器(接続したコンピューターなど
ホスト機器からの電源供給によって駆動されるUSB機器)、
セルフパワー機器(それ自身のために電源接続が必要なUSB
機器)、どちらもお使いになれます。
動作確認済みUSB機器については、ご購入の前にインター
ネット上の下記URLでご確認ください。
http://www.yamaha.co.jp/product/syndtm/

NOTE CD-R/Wドライブを接続した場合、CD-ROMから本体へデータ
を読み込む(ロードする)ことはできますが、本体のデータを保存
(セーブ)してCD-ROMを作ることはできません。

USB記憶装置のフォーマット
USB TO DEVICE端子に接続したUSB記憶装置にMOなど
のメディアを入れた場合、またはそれ自身がメディアとなっ
ているUSB記憶装置(ハードディスクなど)をUSB TO 
DEVICE端子に接続した場合に、そのデバイスがフォーマッ
トを必要とするデバイスのとき、ファイルモードのフォー
マット画面のデバイスリストに「unformat device (usb 
***)」と表示されます。その場合は、フォーマット画面で
フォーマットを実行してください。

NOTE ***には、フォーマットを必要とするデバイスにつけられる通し
番号が表示されます。1つのデバイス内に複数のパーティショ
ンがある場合は、通し番号の横にパーティション番号も表示さ
れます。

USB TO DEVICE端子をご使用になる場合の注意
以下の点にご注意ください。

注意
USB記憶装置の頻繁な電源のオン/オフ(接続したUSB記憶装置が
セルフパワー機器の場合)やUSBケーブルの抜き差しをしないでく
ださい。楽器本体の機能が停止する恐れがあります。ファイル
モードでセーブ/ロード/デリートなどデータのアクセス中に、
USBケーブルを抜いたり、USB記憶装置からメディア(カードや
MOなど)を取り出したり、双方の電源を切ったりしないでくださ
い。メディアがこわれたり、楽器本体/メディアのデータがこわれ
たりするおそれがあります。

USB記憶装置と接続
(ハードディスクなど)

USB TO DEVICE端子USBフラッシュメモリー

または

S90 XS/S70 XS
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付録

メッセージリスト

LCD表示 説明

All data is initialized upon power-on. 
Continue? 

「Power on auto factory set switch」をオンにしてよいかの確認を求める表示です。

Are you sure? 各操作を実行したときの、確認を求める表示です。

Assign Vocoder Voice to Part 1. 
Continue?

パフォーマンス/マルチモードでマイク入力の「OutputSelect」を「Vocoder」にした場合、Part 
1のボイスがボコーダーボイスではなかったときに、ボコーダーボイスをPart 1に割り当てるためカ
テゴリーサーチダイアログを表示するかどうかを確認する表示です。

Assign Vocoder Voice. Continue? ボイスモードでマイク入力の「OutputSelect」を「Vocoder」にした場合、ボイスがボコーダーボ
イスでなかったときに、ボコーダーボイスを選ぶためにカテゴリーサーチダイアログを表示するかど
うかを確認する表示です。

Audio Rec stopped due to lack of memory 
space.

USB記憶装置または内蔵フラッシュメモリーの容量がなくなったので、オーディオレコードを停止
したときに表示されます。

Bad disk or memory. USB記憶装置が不良です。フォーマットを実行してやりなおしてください。

Bulk data protected. バルクデータ受信のプロテクトがかかっています。

Can't execute. 設定や状態が不適切で正しく実行できませんでした。

Click off. クリック(メトロノーム)がオフになりました。

Click on. クリック(メトロノーム)がオンになりました。

Completed. 処理が完了しました。

Connecting to USB device... USB記憶装置を接続中です。

Copied Arpeggio type. Arpeggio Typeの設定をコピーしました。

Device number is off. デバイスナンバーがオフなので、バルクデータを送受信できません。

Device number mismatch. デバイスナンバーが異なるので、バルクデータを受信できません。

Directory is not empty. データの入っているディレクトリーを消去しようとした場合に、表示されます。

Disk or memory is full. 外部記憶装置の容量が一杯でファイルがセーブできない場合に表示されます。新しい外部記憶装置を
用意するか、不要なファイルを消去してから操作をやりなおしてください。

Disk or memory is write-protected. 外部記憶装置が書込み禁止状態になっているか、またはCD-ROMドライブなどへの書き込みを行な
おうとした場合に表示されます。

Disk or memory read/write error. 外部記憶装置へのリード/ライト中にエラーが発生しました。

Executing… 処理を実行中です。

Executing… ****.wav オーディオレコードで作られるオーディオデータを書き込み中に表示されます。「 ****」はファイル
名を表示します。

Executing… 
Please keep power on.

内部メモリーへの書き込みをともなう処理を実行中に表示されます。このとき本体の電源を切らない
でください。

File already exists. 同じ名前のファイルがすでに存在しています。

File is not found. 選択したタイプのファイルがありません。

File path is too long. 開こうとするファイルやディレクトリーのパス名が長すぎて開けません。

Illegal bulk data. バルクデータ、バルクリクエスト受信中にエラーが生じました。

Illegal file name. ファイル名が無効の場合表示されます。

Illegal file. ロードのとき、目的のファイルがS90 XS/S70 XSでは扱えない、または現在のモードではロード
できない場合に表示されます。

Learning… リモートモードでノブ/スライダーのラーニング機能を実行中です。

Load All Arpeggios. Are you sure? ファイルモードで、オールアルペジオをロードするかどうかを確認する場合に表示されます。

Load All Performances. Are you sure? ファイルモードで、オールパフォーマンスをロードするかどうかを確認する場合に表示されます。

Load All Voices. Are you sure? ファイルモードで、オールボイスをロードするかどうかを確認する場合に表示されます。
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Load All without system. Are you sure? ファイルモードでシステム設定をのぞくオールデータをロードするかどうかを確認する場合に表示さ
れます。

Load All. Are you sure? ファイルモードでオールデータをロードするかどうかを確認する場合に表示されます。

Load Seq Chain file. Are you sure? ファイルモードでシーケンスチェーンをロードするかどうかを確認する場合に表示されます。

MIDI buffer full. 一度に大量のMIDIデータを受信したので処理できませんでした。

MIDI checksum error. 受信したシステムエクスクルーシブのチェックサムが違います。

Mixing Voice full. ストアできるミキシングボイスの最大数を超えている場合に表示されます。

No read/write authority to the file. USB記憶装置上で、ファイルの書込み/読み込み権限がありません。

Now executing Factory set... 
Please keep power on.

工場出荷時の設定に書き換え中です。電源を切らないでください。

Now loading... ファイルロード中に表示されます。

Now receiving MIDI bulk data... MIDIバルクデータ受信中に表示されます。

Now saving... ファイルセーブ中に表示されます。

Now scanning autoload file... オートロードするファイルの検索中に表示されます。

Now transmitting MIDI bulk data... MIDIバルクデータ送信中に表示されます。

Overwrite. Are you sure? ファイルをセーブする際に、内蔵フラッシュメモリーやUSB記憶装置内に同名のファイルがある場
合に表示されます。

Part x is used for Drum Assign. パフォーマンスモードで各パートスイッチがすべてオンなので、Part "x"にドラムアサインを実行し
ました。

Part x is used for Layer. パフォーマンスモードで各パートスイッチがすべてオンなので、Part "x"にレイヤーを実行しました。

Part x is used for Split. パフォーマンスモードで各パートスイッチがすべてオンなので、Part "x"にスプリットを実行しました。

Please stop Audio Play/Rec. オーディオレコード/プレイの録音/再生を止めてから操作してください。

Please stop sequencer. シーケンスプレイの再生を止めてから操作してください。

Save Audio Rec file? オーディオレコードで録音したファイルをセーブするかどうか確認する場合に表示されます。

Seq Chain stored. シーケンスチェーンの設定が保存されました。

Sequence memory full. シーケンサー用の内部メモリーが一杯で、レコーディングやエディット、ジョブの実行、MIDIの受
信、内蔵フラッシュメモリーやUSB記憶装置からのデータのロードができないときに表示されます。
不要なソングを消去してから、操作をやりなおしてください。

Set Part 1 Ins Sw to on to use Vocoder. マイク入力のアウトプットセレクトを「Vocoder」に設定するときに、Part 1のインサーションス
イッチがオフなのでボコーダーが使えません。パート1のインサーションスイッチをオンにしてくだ
さい。

MIDI data overload. MIDIデータのファイルサイズが大きすぎて再生できません。

Store Voice ? ボイスモードで、エディット中のボイスに対してパフォーマンスクリエーター (レイヤー /スプリッ
ト/ドラムアサイン)を実行したときに、エディット中のボイスをストアするかどうか確認する場合に
表示されます。

The received MIDI bulk data’s type is not 
compatible with the current mode/voice 
type.

送信したときと違うモードでバルクデータを受信しようとした場合に表示されます。送信時のモード
と同じモードでバルクデータを受信してください。また、受信先のミキシングパートのボイスとその
パートにバルク送信されるボイスのタイプ(ノーマルボイス/ドラムボイス)が違う場合にも表示されま
す。同じタイプのボイスを受信するようにしてください。

This Performance uses User Voices. ロードしたパフォーマンスにはユーザーボイスが使われています。セーブ時と同じボイスがユーザー
ボイスバンクの同じ場所にストアされているかご確認ください。

USB connection terminated. 
Press any button.

USB記憶装置に異常な電流が流れたので接続を遮断しました。接続しているUSB記憶装置を外した
上で、パネル上のなんらかのボタンを押してください。

Utility stored. ユーティリティーモードの設定がストアされました。

LCD表示 説明
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「音が出ない」「音色がおかしい」などといった場合は、まず以下の項目をチェックしてください。また、外部機器にデータの
バックアップをしてから(47ページ)、ファクトリーセット(18ページ)をすることで解決できることもあります。
それでも直らないときは、お買い上げのお店、または巻末のお客様コミュニケーションセンター 音楽制作機器相談窓口、
ヤマハ修理ご相談センターにご連絡ください。

音が鳴らない

■ 本体に外部アンプやスピーカー、ヘッドフォンが接続されていますか? 
本体にはスピーカーが内蔵されていません。音を出すためには、外部アンプやスピーカー、ヘッドフォンなどを接続してください
(16ページ)。

■ 本体と、本体に接続した外部オーディオ機器の電源は、オンになっていますか?

■ 本体と、本体に接続した外部オーディオ機器のマスターボリュームは、十分に上がっていますか?
FOOT CONTROLLER端子にフットコントローラーを接続している場合は、動かしてみてください。

■ スライダーがすべて最小になっていませんか?

■ ローカルコントロールがオフになっていませんか?
このパラメーターがオフの場合、鍵盤を弾いても内部音源は鳴りませんのでご注意ください。

■ 外部MIDIコントローラーによって、MIDIボリュームやエクスプレッションが下がってはいませんか?

■ エフェクトやフィルターの設定は適切ですか?
特に、フィルターをかける場合カットオフ周波数の設定によっては音が出ない場合があります。

■ ボイスのインサーションエフェクトがボコーダーに設定されていませんか？
ボコーダーに設定されている場合は、MIC INPUT端子の設定を適切な値に設定し、MIC INPUT端子に音声を入力しながら発音さ
せてください。またその際、パネルの[INPUT GAIN]ノブが最小になっていないか確認してください。

■ ボリュームやレベルが最小になっていませんか?

■ エレメントスイッチやパートスイッチ、ノートリミット、ベロシティーリミットの設定は適切ですか?

困ったときは

[UTILITY] → MIDI → Local Control 

[VOICE] → [EDIT] → Effect 
[VOICE] → [EDIT] → Filter/EG 

[PERFORM] → [EDIT] → Common → Effect 
[PERFORM] → [EDIT] → Common → Filter/EG 
[PERFORM] → [EDIT] → パート選択 → Filter/EG 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → Common → Effect 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Filter/EG 

[VOICE] → [EDIT] → Effect → Ins Connect Type: vocoder 
[UTILITY] → [VOICE] → A/D Out → Output Select: vocoder 

[UTILITY] → General → Volume 
[VOICE] → [EDIT] → PlayMode → Volume 

[VOICE] → [EDIT] → スライダーファンクションボタンで簡易エレメントエディットモード → スライダー 
[PERFORM] → [EDIT] → Common → PlayMode → Volume 
[PERFORM] → [EDIT] → パート選択 → PlayMode → Volume 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → PlayMode → Volume

[VOICE] → [EDIT] → [MUTE]ボタン点灯 → ナンバー [9]～[16]ボタン (xxページ)
[PERFORM] → [PART ON/OFF] 
[PERFORM] → [EDIT] → パート選択 → PlayMode → Note Limit Lo/Hi 

[PERFORM] → [EDIT] → パート選択 → PlayMode → Velocity Limit Lo/Hi
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困ったときは
■ パフォーマンス/マルチモードで音が出ない場合、各パートにボイスは割り当てられていますか?

■ パフォーマンス/マルチモードで音が出ない場合、各パートの出力設定は適切ですか?

■ マルチモードで音が出ない場合、外部シーケンサーの各出力チャンネル/ポートと、マルチの各パートの受信チャン
ネルは適切ですか?

■ パフォーマンス/マルチモードで音が出ない場合、パートの「Arpeggio Play Only」がオンになっていませんか？

MIC INPUT端子からの音が出ない

■ マイクのスイッチはオンになっていますか？

■ マイクと本体を接続するケーブルは正しく接続されていますか？

■ INPUT GAINノブが最小になっていませんか？

■ [MIC ON/OFF]ボタンがオン（ランプが点灯）になっていますか？

■ A/Dインプットパートのボリュームが最小になっていませんか？

■ エフェクトの設定は適切ですか？

■ A/Dインプットパートの出力設定は適切ですか？

外部MIDI機器からの演奏でスプリットが効果しない

■ パフォーマンスモードの「Split Sw」「Split Lower/Upper」の設定は、本体の鍵盤を演奏したときのみに効果し
ます。

音が鳴り続けて止まらない

■ [ARP ON/OFF]ボタンがオンになっている場合、オフにしてみてください(26ページ)。

■ シーケンスプレイモードの場合は、[START/STOP]ボタンを押してください。

■ クリック(メトロノーム)が鳴り続けている場合は、[SHIFT]ボタンを押しながら[START/STOP]ボタンを押して、
クリックをオフにしてください。

[PERFORM] → [EDIT] → パート選択 → Voice 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Voice

[PERFORM] → [EDIT] → パート選択 → PlayMode → Output Select 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → PlayMode → Output Select 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Voice → Receive Ch

[PERFORM] → [EDIT] → パート選択 → Voice → Arp Play Only 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Voice → Arp Play Only

ノブファンクションボタンでMICを選択 → VOLUMEノブ

[UTILITY] → Voice → A/D FX 
[PERFORM] → [EDIT] → Common → A/D FX
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → Common → A/D FX

[UTILITY] → Voice → A/D Out → Output Select 
[PERFORM] → [EDIT] → Common → A/D Out → Output Select 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → Common → A/D Out → Output Select 
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困ったときは
音が歪む

■ エフェクトの設定は適切ですか?
エフェクトタイプや設定によっては、音が歪む場合があります。

マスターエフェクトがオンになっている場合も、音が歪む場合があります。

■ フィルターの設定は適切ですか？
フィルターをかける場合、レゾナンスによっては音が歪む場合があります。

■ ボリュームを上げすぎていませんか？

音が途切れる

■ 全体の発音数が、最大同時発音数(128音)を超えていませんか? 

和音演奏ができない

■ 発音方式が「モノ(mono)」になっていませんか?
和音演奏をしたい場合は「ポリ(poly)」に設定してください。

音の高さがずれている

■ チューンの設定が、0から大きく離れていませんか？

■ ノートシフトの設定が、0以外の値になっていませんか？

■ ボイスの音の高さがずれている場合、マイクロチューニング設定で特殊な音律が選ばれていませんか？

[VOICE] → [EDIT] → Effect 
[PERFORM] → [EDIT] → Common → Effect 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → Common → Effect 

[UTILITY] → Voice → Master FX 
[PERFORM] → [EDIT] → Common → Effect → Master
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → Common → Effect → Master

[VOICE] → [EDIT] → Filter/EG 
[PERFORM] → [EDIT] → Common → Filter/EG 

[PERFORM] → [EDIT] → パート選択 → Filter/EG 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Filter/EG 

[UTILITY] → General → Volume 
[UTILITY] → General → L&R Gain 
[VOICE] → [EDIT] → PlayMode → Volume 
[PERFORM] → [EDIT] → Common → PlayMode → Volume 

[PERFORM] → [EDIT] → パート選択 → PlayMode → Volume 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → PlayMode → Volume

[VOICE] → [EDIT] → PlayMode → Mono/Poly 
[PERFORM] → [EDIT] → パート選択 → PlayMode → Mono/Poly 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → PlayMode → Mono/Poly 

[UTILITY] → General → Tune 

[UTILITY] → General → Note Shift

[UTILITY] → Micro Tune 
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困ったときは
■ パフォーマンス/マルチの音の高さがずれている場合、各パートのノートシフト、デチューンが0以外に設定されて
いませんか？

エフェクトがかからない

■ REVERB、CHORUSのノブ/スライダーが最小になっていませんか？

■ 各エフェクトで選択されているエフェクトタイプが、スルー (thru)やオフ(off)に設定されていませんか？

■ エフェクトがオフになっていませんか？

■ パフォーマンス/マルチモードの場合、インサーションスイッチの設定は適切ですか？

ボコーダーボイスを選択しても、ボコーダーが効果しない

■ A/Dインプットパートの出力が「vocoder」に設定されていますか？

エディットしていないのにエディットマークが点灯する

■ コントロールスライダーを動かしただけで、パラメーター設定が変更されエディットマークが点灯することがあり
ます。

■ アルペジオタイプによっては、アルペジオを演奏しただけでエディットマークが点灯することがあります。 

アルペジオが鳴らない

■ [ARP ON/OFF]ボタンはオンになっていますか? 

■ MIDIシンクはオートかインターナルに設定されていますか？

■ MIDIシンクがオートのときに、外部MIDIクロックを受信していませんか？

■ アルペジオのタイプでユーザーアルペジオを選択していませんか?
ユーザーアルペジオを使う場合、あらかじめMOTIF XSのユーザーアルペジオデータをS90 XS/S70 XSにロードしておく必要
があります。

■ アルペジオのノートリミットやベロシティーリミットは、適切に設定されていますか?

[PERFORM] → [EDIT] → パート選択 → PlayMode 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → PlayMode

[PERFORM] → [EDIT] → パート選択 → FX Send → Ins Effect Sw 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → FX Send → Ins Effect Sw

[UTILITY] → Voice → A/D Out → Output Select 
[PERFORM] → [EDIT] → Common → A/D Out → Output Select

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → Common → A/D Out → Output Select 

[UTILITY] → MIDI → MIDI sync 

[UTILITY] → MIDI → MIDI sync 

[VOICE] → [EDIT] → Arpeggio → Arp Edit → Note Limit Lo/Hi 
[VOICE] → [EDIT] → Arpeggio → Arp Edit → Velocity Limit Lo/Hi 

[PERFORM] → [EDIT] → パート選択 → Arpeggio → Arp Edit → Note Limit Lo/Hi 
[PERFORM] → [EDIT] → パート選択 → Arpeggio → Arp Edit → Velocity Limit Lo/Hi 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Arpeggio → Arp Edit → Note Limit Lo/Hi 
[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Arpeggio → Arp Edit →Velocity Limit Lo/Hi 
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困ったときは
■ パフォーマンス/マルチモードの場合、各パートのアルペジオスイッチの設定を確認してください。

アルペジオが止まらない

■ 鍵盤から指を離してもアルペジオ再生が止まらない場合は、[HOLD] 1～4ボタンでアルペジオホールドスイッチの
設定をオフにしてください。

パフォーマンスのパートにボイスを割り当てると、ボイスモードとは異なった音で発音する

■ ボイスを割り当てたあと、ボイスモードとは異なった音で発音する場合は、ボイスコンテンツとしてもっている
システムエフェクトなどの一部のコモンパラメーターの設定を、編集中のパフォーマンスにコピーしてください。
さらに、パフォーマンスのリバーブセンドまたはコーラスセンドを確認し、ボイスでの設定と同様のレベルにして
ください。ボイスモードで発音するボイスに近い音で発音するようになります。

本体と接続したコンピューターとの通信がうまくできない

■ コンピューター側でのポート設定はできていますか?

■ ユーティリティーモードで、使用する端子(MIDI、USB)を選んでいますか?

本体と接続したコンピューター /MIDI機器のシーケンスデータを再生させても、本体の
音が適切に鳴らない

■ 本体はマルチモードになっていますか? 
複数のチャンネルを同時に再生するには、マルチモードを選んでください。

バルクダンプデータがうまく送信/受信できない

■ バルク受信(レシーブバルク)をプロテクトしていませんか?
バルク受信をオンに設定してください。

■ 本体のバルクダンプ機能を使って記録したデータを受信するときは、送信時と同じデバイスナンバーに設定する必
要があります。

■ うまく送信できない場合、デバイスナンバーの設定値が、接続しているMIDI機器のデバイスナンバーと一致してい
ますか?

■ (S90 XS/S70 XSエディターを使用時)エディターのダンプインターバルの設定が短くありませんか?
エディター設定で、ダンプインターバルを20ms以上に設定してください。詳しくは、エディターに付属の電子マニュアルをご参
照ください。

[PERFORM] → [EDIT] → パート選択 → Arpeggio → Arp Edit → Arp Sw 

[MULTI/SEQ PLAY] (マルチモード選択) → [EDIT] → パート選択 → Arpeggio → Arp Edit →Arp Sｗ 

[PERFORM] → [JOB] → Copy → Voice 
[PERFORM] → [EDIT] → パート選択 → FX Send 

[UTILITY] → [MIDI] → MIDI In/Out 

[UTILITY] → [MIDI] → Receive Bulk 

[UTILITY] → [MIDI] → Device No. 

[UTILITY] → [MIDI] → Device No. 
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困ったときは
USB記憶装置にセーブできない

■ USB記憶装置にライトプロテクトがかかっていませんか？

■ USB記憶装置は正しくフォーマットされていますか？

オーディオファイルが再生できない

■ オーディオファイルのフォーマットは適切ですか？
再生できるファイルは、44.1kHz/16ビット/ステレオのWAVEファイル (拡張子.wav)/AIFF (拡張子.aif)ファイルです。

エディットモードに入れない

■ ファイルモードになっていませんか?
ファイルモードを抜けてから[EDIT]ボタンを押してください。

[FILE] → Save → USB記憶装置を選択 → [JOB] → FORMAT 
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仕様および外観は改良のため予告なく変更することがあります。

ソースコード配布について
本製品の最終出荷日から3年間は、製品のソースコードのうちGNU General Public License*に基づいてライセンス供与された部分については、ソースコードを配布させていた
だきます。以下の住所にお問い合わせください。

〒430-8650 浜松市中区中沢町10-1
ヤマハ(株) PA・DMI事業部DMIマーケティング部DEグループ

ソースコードの配布自体は無償ですが、ソースコードの送料につきましてはご負担いただきます。
• 弊社(または弊社認定の関係者)以外の第三者による、この製品のソフトウェアに対する変更や追加、削除などによって発生したいかなる損害に対しても、弊社は一切責任を負い
ません。
• 弊社により一般に公開されたソースコードの再利用は保証されておりません。ソースコードに関して弊社は一切責任を負いません。
• また、ソースコードは以下のURL でも配布しております。
http://www.yamaha.co.jp/product/syndtm/dl/source/s_xs/
* GNU General Public Licenseについては、別冊データリストの巻末をご覧ください。

仕様

S90 XS S70 XS

鍵盤 88鍵バランスドハンマー鍵盤
(イニシャルタッチ/アフタータッチ付)

76鍵バランスドハンマー鍵盤
(イニシャルタッチ/アフタータッチ付)

音源部 音源方式 AWM2＋アーティキュレーション機能

最大同時発音数 128音

マルチティンバー数 16パート＋マイク入力パート

波形メモリー 456MB相当(16ビット換算)、2,772ウェーブフォーム

ボイス数 プリセット: 1,024ノーマルボイス＋64ドラムキット
GM: 128ノーマルボイス＋1ドラムキット

ユーザー : 128×4 (バンク1～3: プリセットからのピックアップ)ノーマルボイス
＋32ドラムキット

パフォーマンス数 ユーザー : 128×4 (最大4パート)

マルチ数 ユーザー : 128

フィルター 18タイプ

エフェクター リバーブ×9タイプ、コーラス×22タイプ、インサーション(A、B)×53タイプ
×8パート(計16基)、ボコーダー×1 (インサーションA、Bを一組として使用)、

マスターエフェクト×9タイプ、マスター EQ (5バンド)、パートEQ (3バンド、ステレオ)

シーケンサー部 シーケンスプレイ SMF Format 0/1 (再生のみ)

BPM 5～300

チェーンステップ数 100

アルペジエーター プリセット×6,779タイプ
ユーザー×256タイプ(MOTIF XSのユーザーアルペジオをロードした場合のみ使用可)

オーディオレコード
/プレイ部

対応フォーマット 録音：WAVE (拡張子.wav/44.1kHz/16ビット/ステレオ)
　再生：WAVE (拡張子.wav/44.1kHz/16ビット/ステレオ) 

AIFF (拡張子.aif/44.1kHz/16ビット/ステレオ)

その他 マスターモード設定数 ユーザー：128設定
※4ゾーン(マスターキーボード設定)、アサイナブルノブ/スライダー設定

リモート対応
ソフトウェア

<Windows®> Cubase 5、Cubase 4.5、SONAR 8
<Macintosh®> Cubase 5、Cubase 4.5、Logic Pro 8、Digital Performer 6

※各ソフトウェアの機能によって、リモートコントロールできる内容が異なります。最新の情報はWeb参照

主な操作子 ピッチベンドホイール×1、モジュレーションホイール×1、ノブ×4、スライダー×4、
アサイナブルファンクションボタン×2、データダイアル×1、インプットゲイン×1

ディスプレイ 160×64ドットグラフィックLCD (バックライト付)

接続端子 OUTPUT L/MONO, R (標準フォーンジャック)、ASSIGNABLE OUTPUT L, R (標準フォー
ンジャック)、MIC INPUT (コンボジャック)、PHONES (ステレオ標準フォーンジャック)、
FOOT CONTROLLER 1, 2、FOOT SWITCH×2 (SUSTAIN, ASSIGNABLE)、

MIDI IN/OUT/THRU、USB (TO HOST, TO DEVICE)、AC IN

消費電力 16W

寸法・質量 1,472(W)×385(D)×173(H) mm
22.4 kg

1,320(W)×385(D)×173(H) mm
20.4 kg

付属品 電源コード、2P-3P変換器、保証書、取扱説明書(本書)、
取扱説明書CD-ROM、DVD-ROM (付属ソフトウェア)
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ソフトウェアのご使用条件
弊社では本ソフトウェアのお客様によるご使用およびお客様へのアフターサービスについて、＜ソフトウェア使用許諾契約＞を設けさせていただいてお
り、お客様が下記条項にご同意いただいた場合にのみご使用いただけます。
本ソフトウェアのディスクの包装を解かれた場合は下記条項にご同意いただけたものとさせていただきますので、下記条項を充分お読みの上開封してく
ださい。ご同意いただけない場合は、インストール、コピー、その他のご使用はおやめください。

このソフトウェア使用許諾契約は、本製品に同梱している、スタインバーグ社の付属DAWソフトウェアに関して、お客様のご使用条件を規定するもので
す。付属DAWソフトウェアをインストールする過程で「スタインバーグ･エンドユーザー･ライセンス契約書」が表示されますが、その契約書は、このソ
フトウェア使用許諾契約に置き換えられるために、意味のないものです。インストールする際には、その「スタインバーグ･エンドユーザー･ライセンス
契約書」を無視して「同意します」を一律選択し｢次へ｣をクリックして、次頁(ユーザー登録)に進んでください。

ソフトウェア使用許諾契約

1．著作権および使用許諾
弊社はお客様に対し、ソフトウェアプログラムおよびデータファイル(以
下「本ソフトウェア」といいます。）を使用する権利を許諾します。本契
約条項は、今後お客様に一定の条件付きで配布され得る本ソフトウェア
のバージョンアッププログラム、データファイルにも適用されるものと
します。本ソフトウェアの権利およびその著作権はスタインバーグ社(ド
イツ)にあり、弊社は同社からお客様に使用許諾するためのサブライセン
ス権を得ています。本ソフトウェアの使用によって作成されたデータの
権利はお客様が取得しますが、本ソフトウェアは、関連する著作権法規
のもとで保護されています。
• お客様ご自身が一時に一台のコンピューターにおいてのみ使用するこ
とができます。

• バックアップが許されているものは、バックアップをとる目的でのみ、
機械で読み取れる形式での本ソフトウェアのコピーを作成することが
できます。ただし、そのバックアップコピーには本ソフトウェアに表
示されている弊社の著作権の表示や他の権利帰属についての説明文も
コピーしてください。

• お客様は、製品本体を第三者に譲渡する場合に限り、付属品である本
ソフトウェアを使用する権利を、同じ第三者に譲渡することができま
す。ただし、お客様が本ソフトウェアのコピーを保持せず、かつ譲受
人が本契約条項に同意する場合に限られます。

2. 使用制限
(1) 本ソフトウェアの使用にあたっては、次のことを遵守してください。
• 本ソフトウェアには著作権があり、その保護のため、お客様が本ソフ
トウェアを逆コンパイル、逆アセンブル、リバース・エンジニアリン
グ、またはその他のいかなる方法によっても、人間が感得できる形に
することは許されません。

• 本ソフトウェアの全体または一部を複製、修正、改変、賃貸、リース、
頒布または本ソフトウェアの内容に基づいて二次的著作物をつくるこ
とは許されません。

• 本ソフトウェアをネットワークを通して別のコンピューターに伝送し
たり、ネットワークで他のコンピューターと共有することは許されま
せん。

• 本ソフトウェアを使用して、違法なデータや公序良俗に反するデータ
を配信することは許されません。

• 弊社の許可無く本ソフトウェアの使用を前提としたサービスを立ち上
げることは許されません。

(2) 楽曲用ＭIDIデータ等、本ソフトウェアにより使用または入手できる
著作権曲については次のことを遵守してください。
• 本ソフトウェアの使用によって得られたデータを著作権者の許可なく
営業目的で使用することは許されません。

• 本ソフトウェアの使用によって得られたデータを著作権者の許可なく
複製、転送または配信したり、または不特定多数にむけて再生および
演奏することは許されません。

• 本ソフトウェアの使用によって入手できるデータの暗号を著作権者の
許可無く解除したり、電子透かしを改変したりすることは許されませ
ん。

3. 終了
本契約はお客様が本ソフトウェアをお受け取りになった日に発効します。
本契約は、お客様が著作権法または本契約条項に1つでも違反されたとき
は、弊社からの終了通知がなくても自動的に終了するものとします。そ
の場合には、ただちに本ソフトウェアとそれに関するドキュメンテー
ション、およびそれらのコピーをすべて廃棄しなければなりません。

4. 製品の保証 
本ソフトウェアがディスク等の媒体で販売された場合や、ディスク等の
媒体で製品に同梱された場合には、弊社は、お客様が本ソフトウェアを
お受け取りになった日から14日間に限り(お受け取りの日は、受領書の
写しで証明される日とします）、媒体に物理的な欠陥があった場合には、
その原因が事故、乱用、誤用など弊社の責に帰さない事由による場合を
除き、無償で同種の良品と交換させていただきます。弊社はそれ以上の
保証はいたしません。

5. 本ソフトウェアに関する保証
本ソフトウェアのご使用についての一切のリスクはお客様のご負担とな
ります。
本ソフトウェアの商品性、特定の目的への適合性、第三者の権利を侵害
しないことの保証は明示であると黙示であるとを問わず、一切いたしま
せん。特にお客様の目的に適合することや、ソフトウェアの操作が中断
されないことやソフトウェアの欠陥や瑕疵が修正されることの保証はい
たしません。

6. 責任の制限
弊社の義務は、お客様に本契約条項の条件で本ソフトウェアの使用を許
諾することがすべてです。
弊社は、本ソフトウェアの使用、誤用またはそれを使用できなかったこ
とにより生じた直接的、派生的、付随的または間接的損害(データの破
損、営業上の利益の損失、業務の中断、営業情報の損失などによる損害
を含む)については、通常もしくは特別の損害に拘わらず、たとえそのよ
うな損害の発生の可能性について予め知らされた場合でも、一切責任を
負いません。すべての損害、損失、契約や違法行為等に対する訴訟申立
てについて、いかなる場合も、お客様に対する弊社の責任は、お客様が
本ソフトウェアの購入のために支払った金額を越えることはありません。

7. 一般事項
本契約条項は、弊社の権限ある者の署名のある書面によらない限り、改
訂することはできません。
本契約条項は、日本法の適用を受け、日本法に基づいて解釈されるもの
とします。本契約に関し紛争が生じた場合には東京地方裁判所を専属管
轄裁判所とします。

8. インストール時に表示される契約書
本ソフトウェアをインストールする過程で表示される「スタインバーグ･
エンドユーザー･ライセンス契約書」は、このソフトウェア使用許諾契約
に置き換えられるために、意味のないものです。
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S962
ユーザーサポートサービスのご案内

■ ユーザー登録のお願い
弊社では、ユーザーの方々をサポートし、関連情報をご提供
するために、本製品をご購入いただいたお客様にユーザー登
録をお願いしております。
ユーザー登録手続きは、下記ヤマハホームページよりお願い
します。

*ユーザー登録には、製品本体のシリアル番号(SER No.)が必要になります。

■ 住所/氏名/メールアドレスの変更(同一使用者の
範囲内)

ご登録いただいた「ご住所」、「お名前」、「メールアドレス」
などを変更された場合は、上記ヤマハホームページよりお手
続きください。

■ 質問の受付
ヤマハデジタル製品は、常に新技術/高機能を搭載し技術革
新を進める一方、お使いになる方々の負担とわずらわしさを
軽減できるような製品づくりを進めております。また取扱説
明書の記載内容も、よりわかりやすく使いやすいものにする
ため、研究/改善いたしております。
しかし、一部高機能デジタル製品では、取扱説明書だけでは
説明しきれないほどのいろいろな知識や経験を必要としてし
まうものがあります。
実際の操作に関して、基本項目は取扱説明書に解説いたして
おりますが、「記載内容が理解できない」、「手順通りに動作
しない」、「記載が見つからない」といったさまざまな問題が
起こる場合があります。
そのようなお客様への一助となるよう、弊社では音楽制作機
器相談窓口を開設いたしております。
お気軽にご利用いただきますようご案内申し上げます。
お問い合わせの際には、「製品名」、「シリアル番号(SER 
No.)」をお知らせください。

付属DAWソフトウェアについては、6ページをご参照くだ
さい。

■ ご購入に関するお問い合わせ先

国内営業本部 EKB・LM営業部 営業推進室
〒108-8568 東京都港区高輪2-17-11
TEL. (03) 5488-5430

PA･DMI事業部 DMIマーケティング部 DEグループ
〒430-8650 静岡県浜松市中区中沢町10-1

*都合により、住所、電話番号、名称、営業時間などが変更になる場合が
ございますので、あらかじめご了承ください。

ヤマハホームページ
http://www.yamaha.co.jp/product/syndtm/

お客様コミュニケーションセンター 
音楽制作機器相談窓口

携帯電話、PHS、IP電話からは 053-460-1666
営業時間: 月曜日～金曜日 10:00～18:00、

土曜日 10:00～17:00
(祝日およびセンター指定休日を除く)

http://www.yamaha.co.jp/support/

※一般電話・公衆電話からは、市内通話料金でご利用いただけます。

0570-015-808ナビダイヤル
(全国共通番号)

ヤマハデジタル楽器･DTM製品ホームページ
http://www.yamaha.co.jp/product/syndtm/

ヤマハマニュアルライブラリー
http://www.yamaha.co.jp/manual/japan/

あなたの音楽生活をフルサポートミュージックイークラブ
http://www.music-eclub.com/

お客様サポート&サービス
http://www.yamaha.co.jp/support/
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保証とアフターサービス
サービスのご依頼、お問い合わせは、お買い上げ店、または
ヤマハ修理ご相談センターにご連絡ください。

● 保証書
本機には保証書がついています。
保証書は販売店がお渡ししますので、必ず「販売店印・お買
い上げ日」などの記入をお確かめのうえ、大切に保管してく
ださい。

● 保証期間
お買い上げ日から1年間です。

● 保証期間中の修理
保証書記載内容に基づいて修理いたします。詳しくは保証書
をご覧ください。

● 保証期間経過後の修理
修理すれば使用できる場合は、ご希望により有料にて修理さ
せていただきます。
下記の部品については、使用時間や使用環境などにより劣化
しやすいため、消耗に応じて部品の交換が必要となります。
消耗部品の交換は、お買い上げ店またはヤマハ修理ご相談セ
ンターへご相談ください。

● 補修用性能部品の最低保有期間
製品の機能を維持するために必要な部品の最低保有期間は、
製造打切後8年です。

● 修理のご依頼
まず本書の「困ったときは」をよくお読みのうえ、もう一度
お調べください。
それでも異常があるときは、お買い上げの販売店、または
ヤマハ修理ご相談センターへ修理をお申し付けください。

● 製品の状態は詳しく
修理をご依頼いただくときは、製品名、モデル名などとあわ
せて、故障の状態をできるだけ詳しくお知らせください。

◆ 修理に関するお問い合わせ
ヤマハ修理ご相談センター

携帯電話、PHS、IP電話からは TEL 053-460-4830
受付時間 月曜日～金曜日 9:00～18:00、

土曜日 9:00～17:00
(祝日およびセンター指定休日を除く)

FAX 053-463-1127

◆ 修理品お持込み窓口
受付時間 月曜日～金曜日 9:00～17:45

（浜松サービスステーションは8:45～17:30）
(祝日および弊社休業日を除く)

* お電話は、ヤマハ修理ご相談センターでお受けします。

北海道サービスステーション
〒064-8543
札幌市中央区南10条西1丁目1-50 ヤマハセンター内
FAX (011) 512-6109

首都圏サービスセンター
〒143-0006
東京都大田区平和島2丁目1-1 京浜トラックターミナル内
14号棟A-5F
FAX (03) 5762-2125

浜松サービスステーション
〒435-0016
浜松市東区和田町200 ヤマハ(株)和田工場内
FAX (053) 462-9244

名古屋サービスセンター
〒454-0058
名古屋市中川区玉川町2丁目1-2 ヤマハ(株)名古屋倉庫3F
FAX (052) 652-0043

大阪サービスセンター
〒564-0052
吹田市広芝町10-28 オーク江坂ビルディング2F
FAX (06) 6330-5535

九州サービスステーション
〒812-8508
福岡市博多区博多駅前2丁目11-4
FAX (092) 472-2137

*名称、住所、電話番号などは変更になる場合があります。

消耗部品の例
ボリュームコントロール、スイッチ、ランプ、リレー類、
接続端子、鍵盤機構部品、鍵盤接点など

※一般電話・公衆電話からは、市内通話料金でご利用いただけます。

0570-012-808ナビダイヤル
(全国共通番号)
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ヤマハデジタル楽器･DTM製品ホームページ
http://www.yamaha.co.jp/product/syndtm/

ヤマハマニュアルライブラリー　
http://www.yamaha.co.jp/manual/japan/

あなたの音楽生活をフルサポート　ミュージックイークラブ
http://www.music-eclub.com/

お客様サポート&サービス　
http://www.yamaha.co.jp/support/
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